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Preface

Thank you for purchasing our product.
This Operator’s Manual describes how to use the fax functions and perform maintenance, etc.
Read this manual before using the functions.

Bl How to read this manual

O Symbols in this manual

In this manual, some important items are described with the symbols shown below. Be sure to read these items
before using this equipment.

A WARNING Indicates a potentially hazardous situation which, if not avoided, could result in death, serious
injury, or serious damage, or fire in the equipment or surrounding objects.

Indicates a potentially hazardous situation which, if not avoided, could result in minor or
A CAUTION moderate injury, partial damage to the equipment or surrounding objects, or loss of data.

Indicates information to which you should pay attention when operating the equipment.
Tip Describes handy information that is useful to know when operating the equipment.
n References describing items related to what you are currently doing. See these references as

required.

QO Description of original/paper direction

Paper or originals of A4, B5 or LT size can be placed either in a portrait direction or in a landscape direction. In this
manual, “-R” is added to this paper size when this size of paper or original is placed in a landscape direction.

Example: A4 size original on the original glass

Placed in a portrait direction: A4 Placed in a landscape direction: A4-R

Paper or originals of A3, B4, LD or LG can only be placed in a landscape direction, therefore “-R” is not added to these
sizes.

U Model and series names in this manual

In this manual, each model name is replaced with the series name as shown below.

Model name Series name
e-STUDIO2020AC/2520AC e-STUDIO6525AC Series
e-STUDIO2525AC/3025AC/3525AC/4525AC/5525AC/6525AC

e-STUDIO2528A/3028A/3528A/4528A/5528A/6528A e-STUDIO6528A Series
e-STUDIO6526AC/6527AC/7527AC e-STUDIO7527AC Series
e-STUDIO6529A/7529A/9029A e-STUDIO9029A Series
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O Optional equipment

For available options, see the reference below:
Information About Equipment - Information About Equipment - Options

O Screens in this manual

* In this manual, Windows 10 is taken for explanation purposes to describe the screens and operation procedures in
Windows.

* The details on the screens may differ depending on your model and how the equipment is used, such as the status
of the installed options, the OS version and the applications.

* Theillustration screens used in this manual are for paper in the A/B format. If you use paper in the LT format, the
display or the order of buttons in the illustrations may differ from that of your equipment.

O Abbreviations in this manual

In this manual, “Dual Scan Document Feeder”(DSDF) and “Reversing Automatic Document Feeder”(RADF) are
collectively referred to as “Automatic Document Feeder”(ADF). In this manual, “Dual Scan Document Feeder” is
referred to as “DSDF” and “Reversing Automatic Document Feeder” as “RADF”.

O Trademarks

For trademarks, refer to the Safety Information.

M Features and Functions
Installing the FAX unit in this equipment will make the following fax functions usable.

e Faxfunction
Faxes can be sent and received by using a phone line.

* Network Fax function
The Network Fax features can simplify and facilitate your office facsimile needs and enables you to send fax or
Internet Fax digital documents directly from your computer.
Installing the highly intuitive, network N/W-Fax driver software enables you to send fax or Internet Fax digital
documents from your computer to one or more recipients.
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Description of Each Component

H Control panel

For details of the buttons on the control panel, see the reference below:
Information About Equipment - Information About Equipment - Description of Components - Control Panel

H Touch panel

This section describes the fax screen on the touch panel.

22 21 20 1918

Clear All Dest. = Sta Gotion
A bl i | L]
5

1. Functiondisplay
The function being used is displayed.
2. Message indication area
This shows a brief description of the functions or the current status of this equipment in message form.
3. Destination indication area (£ P.27)
The number of the selected recipients and their names are displayed.
4. [ClearAll Dest.] button (EJ P.31)
This is to clear all the displayed recipients in the destination indication area.
5. Original size setting button (L P.22)
This is to set the original size.
6. Resolution setting button (£ P.23)
This is to set the resolution when scanning an original.
7. Option setting button (EJ P.24)
This is to set the option.
8. Dateandtime
The current date and time are shown here.
9. [Job Status] button (£ P.36)
This is to view the job status or its history.
10. [Preview] button (Ed P.32)
This is to display a preview of a scanned image before the transmission.
11. [Send] button (EJ P.19)
This is to send a fax job.
12. Addressindication area (Ed P.28)
The recipients registered in the address book are displayed. For details of the registration to the address book,
see the references below:
TopAccess - [Registration] - [Registration] Overview - [Address Book] Item list
User Functions - SETTING ITEMS (User) - Address - Managing contacts in address book - Creating new
contacts

When an individual recipient is selected from the address book, confirm that the selected one is displayed on the
recipient list on the left side of the screen.

13. Search button (EJ P.28)
This is to search the recipients.
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14,

15.

16.

17.

18.

19.

20.

21.

22.

Favorite/index buttons

This is to refine the recipients registered in the address book. When you press ﬂ, only the recipients registered
in the favorite are displayed in the address indication area. When you press any of the index buttons, only the
applicable recipients registered in each index are displayed in the address indication area.

Address book switch buttons

This is to switch the local or shared address book. These buttons are displayed only when the use of the shared
address book is available. For details about the shared address book, see the reference below:

TopAccess - [Registration] - [Registration] Overview - [Address Book] Item list

Recipient selection method switch tab (Ed P.27)

This is to switch the selection method of the recipients.

On-hook transmission button (Ed P.34)

This is to perform on-hook transmission.

[?1(Help) button

This is to view the explanation of each function or the buttons on the touch panel.

Language button

This is to switch a language.

Adding to Home screen button

This is to add a setting such as a job setting to the Home screen. For details, see the reference below:
Template - REGISTERING JOB SETTINGS ONTO THE HOME SCREEN - Registering Job Settings onto the Home
Screen

[Settings] button

This is to check currently set functions.

[Storage] button (I P.69)

This is for the storage function.

Tip

When this equipment is managed under the department management or user management, key in user information
such as the department code, user name and password to display the operation screen. For details of the operation,
see the reference below:

Information About Equipment - Information About Equipment - Logging in

H Options

This section describes the options related to the fax function.

FAX Unit
This unit enables the use of the fax function. Two fax units can be installed in one piece of equipment at a
maximum. Install two fax units if you want to send/receive faxes using 2 lines.

The 2nd line for FAX Unit is not available to some models.

l Simple Fax

The equipment provides an independent menu called “Simple Fax” so that you can send faxes with minimum
operations.

To learn how to use the menu, see the reference below.

Basic Operation - Simple Fax

Description of Each Component 11
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Connecting Cables

Be sure that the power of the MFP is turned OFF before connecting the cables.

e-STUDIOG6525AC Series [ e-STUDIO6528A Series

e-STUDIO7527AC Series/ e-STUDIO9029A Series

1. LINE
Connect a public network line.
2. LINE2

Connect a public network line when multiple fax units are installed.
Tip
LINE2 is not available to some models.

3. TEL
Connect an external telephone.

* Do not connect the cable for a public network line into the TEL. Otherwise, the MFP may malfunction.
* Do not connect the MFP and the external telephone to a public network line in parallel.
* Use the external telephone without an answerphone (or with the function off) to be connected with the TEL.
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Operating the Fax unit

M Placing an original

O Originals that can be sent

Operating the Fax unit, you can send a fax of the following originals.

You can place 1-sided or 2-sided originals of media types, such as plain paper, recycled paper and paper having holes
(2,3 or 4 holes) for filing, on the RADF (Reversing Automatic Document Feeder) or DSDF (Dual Scan Document Feeder).
When the original glass is used, originals such as overhead transparencies, tracing paper, booklet or 3-dimensional
objects, that cannot be placed on the ADF can be scanned, as well as plain paper.

Location Maximum size Paper weight Original size
Original glass - North American format:
LD, LG, LT, LT-R, ST, ST-R, COMP
A/B format:
A3, A4, A4-R, A5, A5-R, B4, B5, B5-R,
FOLIO

ADF | RADF | Length:297mm 'y qigeq originals:

(11.697) 35-157g/m2(9.3-41.81b.)
Width: 432 mm 2-sided originals: North American format:

17.01"
( ) 50-157 g/m2(13.3-41.8|b.) LD, LG, LT, LT-R, ST-R, COMP
- — A/B format:
DSDF 1-sided originals: A3, A4, A4-R, A5-R, B4, B5, B5-R, FOLIO
35-209g/m2*(9.3-41.81b.) (ST/A5 is not available)

2-sided originals:
50-209 g/m2"(13.3-41.81b.)

* You may not obtain enough image quality when an original with a paper weight of more than 157 g/m? (41.8 [b.) is used.

* Do not place any heavy objects (4 kg/9 lb. or over) on the original glass and do not press on it with force.
* If the original is any of the following sizes, it is automatically rotated and sent as described below. This function is
not available to some models.
A4 to A4-R
A5-Rto A5
B5-Rto B5
LTto LT-R
ST-Rto ST
* You need to select the original size by yourself when placing the following originals whose sizes cannot be detected
correctly:
- Highly transparent originals (e.g. overhead transparencies, tracing paper)
- Totally dark originals or originals with dark borders
- Non-standard size originals (e.g. newspapers, magazines)
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Q Original scanning range

The following figures show the original scanning area. Any information in the shaded area is not printed on the paper.

1. LD,LG,LT-R,ST-R,COMP, A3, A4-R, A5-R, B4, B5-R, FOLIO
2. LT,ST,A4,A5,B5

1 2
______ 2 mm [.____2mm
(0.08") (0.08")
""" 2 mm
: : (0.08")
2 mm 2 mm
(0.08") (0.08") . : 2mm
5 5 (0.08")
2 m'm 2 ;nm
(0.08") (0.08")

QO Placing the original(s) on the original glass

This section describes how to set an original on the original glass.
Originals are sent in the order they are placed on the original glass.

1 Raise the original cover or ADF, and place the original with its face down.

Raise it at least 60 degrees to allow the original to be detected appropriately.
You need to set the size of the original manually to some models.

2 Align the original against the left inner corner of the glass.

* Different size originals can also be sent in one transmission.

* When an original of any size other than LT/A4 is placed in the direction shown in the above left-hand figure,
transmission to a recipient is carried out so that the pre-entered sender information is printed in position Ain

the figure.

* When an original of LT/A4 size is placed in the direction shown in the above right figure, transmission to a
recipient is carried out so that the pre-entered sender information is printed in position B in the figure.

* The contents registered in the Terminal ID or sender name are reflected in the sender information.
For details about the registration method of the Terminal ID and sender name, see the reference below:

User Functions - SETTING ITEMS (Admin) - Fax - Registering the terminal ID
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3 Lower the original cover or ADF slowly.

Q Placing the original(s) on the ADF

This section describes how to set the original(s) on the ADF. When the originals are placed on the RADF, the uppermost
page is the first to be scanned and sent.

After aligning the originals, place them with their face up and slide the guides to rest against the
edges of the originals.

¢ When the DSDF (Dual Scan Document Feeder) is used:
Regardless of the paper size, originals are acceptable up to 300 sheets (35 to 80 g/m?2 (9.3 to 20 Ib. Bond)) or 38
mm (1.50") in height.

* When the RADF (Reversing Automatic Document Feeder) is used:
Regardless of the paper size, originals are acceptable up to 100 sheets (35 to 80 g/m?2 (9.3 t0 20 |b.)) or 16 mm
(0.62") in height.

* 2-sided originals can be set and sent.
P.21 “Setting the transmission conditions”

* When an original of any size other than LT/A4 is placed in the direction shown in the above left-hand figure,
transmission to a recipient is carried out so that the pre-entered sender information is printed in position Ain
the figure.

* When an original of LT/A4 size is placed in the direction shown in the above right figure, transmission to a
recipient is carried out so that the pre-entered sender information is printed in position B in the figure.

* The contents registered in the Terminal ID or sender name are reflected in the sender information.
For details about the registration method of the Terminal ID and sender name, see the reference below:
User Functions - SETTING ITEMS (Admin) - Fax - Registering the terminal ID
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Placing 2-sided originals

To set 2-sided originals of the LT/A4 size, change their direction depending on their bound positions as follows.
1. Right-to-left (book-type) original

2. Top-to-bottom (tablet-type) original

1

A

Tip
When sending a 2-sided original, it is necessary to select the 2-sided setting as the transmission condition.
P.21 “Setting the transmission conditions”

Sending different size originals

To set different width originals, adjust the side guides to the widest original size, and then align the original against
the front side. Available combinations of the original size are as follows.

* A/Bformat: A3, A4, B4, B5, A4-R, FOLIO

¢ North American format: LD, LT, COMP, LG, LT-R

Tip

To send different width originals, you need to enable “Different Width” as a transmission condition.
P.21 “Setting the transmission conditions”
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Notes for using the ADF

Do not use the following types of original as they may cause a paper misfeed or damage to the equipment:

Originals that are folded or curled

Originals with carbon copies

Originals that have been taped, pasted, or cut-out

Originals with multiple holes punched (e.g. loose leaf paper)
Originals that have been clipped or stapled

Originals with holes or tears

Originals that are damp

Originals whose correction fluid or ink has not been dried completely
Overhead transparencies or tracing paper

Coated paper (e.g. coated with wax)

India paper (used for dictionaries, bibles, etc.)
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The following types of originals can be used but need extra care:

1. Originals that you cannot slide with your fingers or whose surface is specially treated
They should be fanned well before loading since they may not be able to be separated from each other at
feeding.

2. Originals that are folded or curled
They should be smoothed out before being loaded.

1
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H Sending a Fax

This section describes the basic procedures to send a fax. For details of in-depth operations, see the section under
each procedure as required.

Besides the basic sending functions described in this section, there are various useful ways to send a fax. These
procedures are described in the references below:

P.34 “On-hook transmission/Off-hook transmission”

P.49 “USING THE FAX UNIT (USEFUL FUNCTIONS)”

1 Place the original(s).
Check the original size and scanning range, etc. Place the original(s) in the correct direction on the original glass
or ADF.
P.14 “Placing an original”

2 Press [Fax] on the Home screen.
The fax screen is displayed. If you leave the screen unattended for the period of the auto clear setting time (45
sec. by default), the screen returns to the default one automatically.

3 Set the original size, resolution and other necessary conditions.
Fax o ® @

Select contact.
Monitor

Destination 0000
Shared

Q) AWl | ABC DEF | GHI | JKL MNO | K ) Q

0001 0001 0002
& User 001 User 001 &l User 002
] ] ] ]

0003

0002 o 0003
= User 002 ( User 003 ] User 003

0004 0004
& User 004 o | lser 004 lser 005

Job Status

Press each button to display the transmission condition setting screen. For details, see the reference below:
P.21 “Setting the transmission conditions”
4 Specify the recipient.
Fax

Press Send button or START button.

Shared
Q) AL ABC |DEF | GHI  JKL MNO | F Q

0001 0002
- User 001 @l User 002
]

0002 0003
= User 002 User 003
)

Clear All Dest.

Job Status

There are multiple methods to specify the recipients. For details, see the reference below:
P.27 “Specifying the recipient”

To display the preview screen, press [Preview].

P.32 “Displaying the preview before sending a fax”
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5 Press [Send].
Fax Settings ﬂ (i 7 ]

Press Send button or START button.
Dial

Destination 0001

ol User 001

Shared

ABC | DEF | GHI | JKL MNO | Q

0001 0002
User 001 & User 002
] ] |

0003 0003
i User 003 User 003
] ]

0004 0005
o lser 004 & User 005

Clear All Dest. B Auto = Standard Option B Preview

The fax is sent or reserved.
Tip

* Alternatively, you can press the [START] button on the control panel to send a fax.

In the memory transmission mode, the original is scanned into memory. Once a connection has been made,
this equipment automatically starts sending the scanned document. In the direct transmission mode, the fax
number is dialed immediately, and the scanned document will be sent. (Transmission conditions can be set in
the transmission condition setting screen.)

If memory becomes full during scanning in the memory transmission mode, that original will not be stored in
memory. When that happens, reduce the number of originals you are sending, or try sending them in the direct
transmission mode.

You can check the status of the current sending. You can also cancel the transmission (deletes the job).

P.42 “Checking Communication Status”

P.45 “Canceling the Transmission”

Redial function

In the memory transmission mode, if the fax cannot be sent due to a busy-line, the fax number is redialed
automatically to send the fax. By default, this equipment redials 3 times at 1-minute intervals.
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Sending the next original

If an original is placed on the original glass and its scanning is completed, the confirmation screen for the next
original is displayed. If you want to continue scanning of the next original, place it on the original glass, and
then press the [START] button on the control panel. Once all the originals are scanned, press [Job Finish]. If you
place an original on the ADF and press [Continue] during scanning, the confirmation screen for the next original
can be displayed after the scanning is completed.

Scanning

To continue, place de g T or [Scan].

Scan Page Original Size

Job Cancel Option

* If you leave the screen unattended for a period of the auto clearance setting time (45 sec. by default), a copy
of the scanned originals is sent.
* To cancel the transmission in the memory transmission mode, press [Job Cancel].

P.45 “Canceling memory transmission job”
* To change the transmission conditions for each page, press [Option].

P.26 “Changing the settings for each page”

l Setting the transmission conditions
You can set the fax transmission conditions.

Tip

* The transmission conditions are only applied to the current transmission. They return to the default settings after
the transmission.

* To change the default values of each item, see the reference below:
User Functions - SETTING ITEMS (User) - Fax
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0 Setting the original size

You can set the original size.

1 Press E in the Fax menu.
Fax Storage Settings ﬂ @ 0

Select contact.
Monitor

Destination 0000
Shared

ABC | DEF | GHI | JKL MNO % Q

o021 0002
- User 001 B User 002
(] I

0003 0003
User 003 User 003
o I

0004 0005
o | Iser (04 & Lser O05
Option ﬂ\ Preview

Job Status

Storage Settings

Different Width

* Original Size
Set the scan size of the original.
- Auto: The size of the original is automatically determined before the original is scanned.
- Different Width: Select this function to load the originals with different width into the ADF.
- Specified size: The original is scanned at the preset size regardless of its actual size.

Tip
* Setup items differ depending on the model.

* Ifthe recipient’s fax machine is not capable of receiving originals of B5/B5-R size, this equipment may reduce
that size before sending it. To avoid this, when the original to be set is BS and B5-R size, specify A4 and A4-R

size respectively.
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0 Setting the resolution

You can set the resolution when scanning an original.

1 Press ﬁ in the Fax menu.

Fax Storage Settings ﬂ ®

Select contact.
Monitor

Destination 0000
Shared

ABC | DEF | GHI | JKL MNO % Q

o021 0002
- User 001 B User 002
(] I

0003 0003
User 003 User 003
o I

0004 0005
o |ser 004 & User 005

Option ﬂ\ Preview

Job Status

Resolution

Set the resolution, press [OK]

U-Fine

Fine

Standard

Cancel

* Resolution
Set the resolution based on the fineness of the original.

- U-Fine: This is suitable for an original with ultra-fine illustrations.

- Fine: This is suitable for an original with small size text and fine illustrations.

- Standard: This is suitable for an original with regular size text.

Tip

If the recipient’s fax machine is not capable of receiving originals at the same resolution, the resolution is
automatically converted before being sent to the recipient. The higher the resolution is, the longer it takes to

send an original.
Standard cannot be set in Resolution while the OCR function is enabled.
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QO Setting other transmission conditions

1 Press [Option] in the Fax menu.
Fax W ® e

Select contact.
Monitor

Shared

ABC | DEF | GHI | JKL MNO ) Q

00e1 0002
- User 001 il User 002
[ ] I

0002 0003 0003
User 002 User 003 User 003
] ser c= Iser ™~ ser 003

0004 0004 0005
& User 004 o Jser 004 & User 005

=% Standard B Preview

Job Status

Option

Set the Option.
ext
el Original
o Resolution ﬁ Mode

(Terminal ID)

Fax Setting

Internet Fax
Setting

From Name Advanced

* Original Size
This is the same value as the one which can be set on the Fax menu. For details, see the reference below:
P.22 “Setting the original size”

¢ Resolution
This is the same value as the one which can be set on the Fax menu. For details, see the reference below:
P.24 “Setting other transmission conditions”

¢ Original Mode
Set the scanning mode based on the type of the original.

- Text/Photo: This is suitable for an original with a mixture of text and photos.
- Text: This is suitable for an original with text and line drawings.

- Photo: This is suitable for an original with photos.

e Exposure
Set the density at which the original is to be scanned.
- Auto: This equipment automatically detects the contrast of the original, and scans it with the optimum
density.
- Manual: Press I or B to set the desired contrast.

¢ 2-Sided Scan
Select the type (1-sided or 2-sided) of the original to be scanned

- 1Side: Press this button to scan a 1-sided original.
- Book: Press this button to scan a 2-sided right-to-left (book-type) original.
- Tablet: Press this button to scan a 2-sided top-to-bottom (tablet-type) original.
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* From Name
Set the sender name to be added to the transmission record. When you do not set this, the terminal ID is
displayed.
You can register the sender name on the Admin menu. For details, see the reference below:
User Functions - SETTING ITEMS (Admin) - Fax - Registering the terminal ID

* Fax Setting
If you want to change each item for the Fax Setting, see the reference below:
P.25 “Changing the Fax Settings”

¢ Internet Fax Setting
If you want to change each item for the Internet Fax Setting, see the reference below:
P.26 “Changing the Internet Fax Settings”

¢ Advanced
If you want to change the advanced conditions for each item, see the reference below:
P.49 “USING THE FAX UNIT (USEFUL FUNCTIONS)”

Tip
In the [Text/Photo] or [Photo], transmission time may be longer than that in the [Text].

Changing the Fax Settings

Fax Setting

Set the Fax Setting. The changed settings take p

Memory Tx On

Tx Type ECM for G3 Line Select

Off off

Mailbox

Quality Tx Line Monitor Comaication

To cancel the operation and return to the previous screen, press [Reset].

* TxType
Set the fax transmission mode.

- Memory Tx: Send the original after the scanned data are saved in the memory. Up to 100 transmissions of up to
1000 pages per 1 transmission can be reserved.

- Direct Tx: Send the original directly as it is being scanned. Once a page has been scanned and sent, the next
page is scanned and sent. Therefore, it takes longer to scan and send all pages. However, you can confirm on the
fly that each page is sent to the recipient.

* ECM for G3
Switch the ECM (Error Correction Mode) communication On or Off for G3 fax. ECM is an internationally standardized
communication mode that automatically corrects errors that occur during fax transmissions. With this setting
option On, even when the transmitted data have been affected by noise during communication, this mode allows
good communication without image distortion by automatically resending the parts that have been affected.

¢ Quality Tx
Switch Quality Tx On or Off. When this mode is set to On, originals are sent at a slower speed than usual and the
chances of errors occurring decrease.

* Line Select
Specify the line to be used for sending a fax when multiple fax units are installed.

- Auto: The line is switched automatically.
- Line 1: The 1st line is used.
- Line 2: The 2nd line is used.
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* Mailbox Communication
For the communication compatible with ITU-T (International Telecommunications Union-Telecommunications)

standards, specify a subaddress or password to be sent to the recipient’s fax machine. (Up to 20 digits can be
entered.)

SUB (Subaddress): Information to send data of the original to the fax machine.

SEP (Selective Polling): Information to retrieve data of the original from the fax machine.
SID (Sender Identification): Password for SUB.

- PWD (Password): Password for SEP.

* Line Monitor
Switch the line monitoring function to [On] or [Off].

* Both the sender and the receiver must have the ECM function to make ECM communication available.

* When affected by noise during communication, communication time is slightly longer than usual. Even when
the ECM communication is used, an error may occur depending on the line status.

* The ECM communication is not available for voice communication.

* The setting condition in the address book takes the priority. Therefore, when the recipient’s Quality Tx is set to
On in the address book, a fax transmission is performed at On even though the Quality Tx remains Off in the
Option screen.

* Line Select cannot be selected on some models.

Tip
To use the Mailbox Communication function, the recipient’s fax machine must be capable of setting an ITU-T
compatible subaddress or password.

Changing the Internet Fax Settings

This is not applicable to standard fax sending.
P.114 “Sending Internet faxes”

* Subject: The subject of the Internet Fax.
* Body: The body of the Internet Fax.

O Changing the settings for each page

You can change the scanning conditions (Resolution, Mode, Exposure, and Original) for each page.

Specify the recipients and press [Send] to start scanning a document. When the scanning of the
original is completed, the confirmation screen for the next original is displayed. Press [Option].

Scanning

T ue, place

Scan Page Original Size

1 A4

Job Cancel Job Finish | @ Scan

The screen above is displayed when the original placed on the original glass. If you place an original on the ADF
and press [Continue] during scanning, the confirmation screen for the next original is displayed after the
scanning is completed. If you press [Stop] displayed on the screen during scanning, it will be halted and the
confirmation screen for the next original can be displayed.

2 The setting screen for the scanning conditions is displayed. Change the settings, and then press
[OK].
P.24 “Setting other transmission conditions”
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H Specifying the recipient

There are various ways to specify the recipient, such as direct entry with the control panel and address book entry.

Tip

* To use the address book, you need to register recipients’ fax numbers to the book in advance. For details of the

operation, see the references below:
TopAccess - [Registration] - [Registration] Overview - [Address Book] Item list

User Functions - SETTING ITEMS (User) - Address - Managing contacts in address book - Creating new

contacts
* To send to multiple addresses

In the memory transmission mode, you can send the same document to multiple recipients (up to 400 recipients) at
once. When [Multi] is pressed after the fax number has been entered, it will be added to the recipient list displayed
on the left-hand side of the screen. Repeat this operation until you specify all recipients. You can also specify up to

a total of 400 recipients’ fax numbers by combining with other entry methods.

QO Entering directly with digital keys

You can specify the recipient by entering its fax number on the touch panel.

1 Press ﬁ

Fax Settings ﬂ ® 0

Select contact.
Monitor
Destination 0000
Shared

All | ABC |DEF | GHI | JKL | MNO F) Q

0001 0002
User 001 & User 002
= ] |

0003 0003
8 User 003 User 003
] =

0004 0005
o lser D04 & Lser 005

=22 standard Option B Preview

Job Status

Fax T ® e

Input fax number.
Monitor

Destination 0000

Pause
Back Space

Clear

Press to key in the recipient’s E-mail address (internet fax) directly.
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QO Specifying the recipient in the address book

In the address book, you can specify the recipient.

1 Press the desired recipient on the E tab.

Fax
Press Send button or START button.

Shared

ABC | DEF | GHI | JKL [MNO | Q

0001
or 001 ] User 001

0002 Q@ 0003
User 00; User 003
= A

0004 0004
B <er 004 o | Jsor 04

Clear All Dest. uto Option | Pr ' Send |

Job Status

* To cancel the selected recipient, press it again.

* To confirm the selected recipient or delete an unnecessary recipient, press it in the recipient list displayed on
the left-hand side of the screen.
P.31 “Confirming/Deleting the recipients”

* To refine your search only for items including specified characters, press .
P.28 “Searching from the address book or LDAP server”

Tip
When you set your favorite or index items in the address book in the registration, the corresponding recipients

appear on the ﬂ (favorite) tab or index tab.

QO Searching from the address book or LDAP server

You can search for the recipient’s fax number from the address book or LDAP server.

Tip
To search for the recipient’s fax number from the LDAP (Lightweight Directory Access Protocol) server, the name of
the LDAP server to be connected is required to be registered to the MFP in advance. For details on the LDAP server, ask
your network administrator.

1 Select the E or E tab and press .

Fax Settings ﬂ ® 0

Select contact.
Monitor
Destination 0000

Shared

All | ABC | DEF | GHI | JKL |MNO %

6001 0001 0002
& User 001 User 601 B User 002
(EEs - [

0002 0003 0003
= User 002 @l User 003 P User 003
(o

0004 0004 0005
B User 004 o Jser 004 & User 005

Job Status

* Todisplay the recipient search menu, press while the address list is displayed.

* Todisplay the group search menu, press while the group list is displayed.
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2 Enter the keyword in the category which you want to use for searching. Press [Search].

Fax Settings ﬂ D 0

Select contact.
Monitor

Destination 0000
3 Q Search

Location  MFP Local
Known ID
Index
First Name

Last Name

You can search for the desired recipient’s fax number by specifying multiple keywords.
You can search for contacts even if you enter the partial strings. If you enter multiple search conditions, only the
contacts which meet all the entered conditions are displayed as the search results.

Location
Select a location where the address book to be searched is stored. By selecting “MFP Local”, you can search
the address book of this equipment and a shared address book.

Known ID
Use it when you want to search with the Known IDs registered in the address book. You can specify the range
of the ID numbers.

Index
Use this when you want to search with the index registered in the address book.

First Name
Use this when you want to search with the first name registered in the address book.

Last Name
Use this when you want to search with the last name registered in the address book.

Corp.
Use this when you want to search with the corporate name registered in the address book.

Dept.
Use this when you want to search with the department registered in the address book.

Keyword
Use this when you want to search with the characters written in the Keyword which are registered in the
address book.

Fax No.

Use this when you want to search with the fax number registered in the address book.
E-mail

Use this when you want to search with the E-mail address registered in the address book.

Send Type
Use this when you want to search either fax number or E-mail address.
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Selecting the LDAP server
To search for the recipient’s fax number in the LDAP server, select the one you want to search in the pull-

down menu of Location on the Search screen.

Fax Storage Settings @" @ 0

Select contact.
Monitor

Destination
2 Q Search Clear

Location | papo1
Known ID
Index
First Name

Last Name

=% Standard Option B Preview

Job Status

Fax Storage Settings o ® e

Press Send button or START button.
Dial

Research Known ID Sor! v Result: 60 X

0001
v User 001

HCE

0002 0003
e &l User 003
(]

0004 0004
B User 004 User 004
] |

Clear All Dest. & Auto S Standard Option

* To cancel the selected recipient, press it again.

* If you want to change the results of the search, press [Research]. You will be returned to the screen in step 2.
Specify the search string again.

* You can switch the screen by selecting [Known ID Sort] or [Index Sort].
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Q Specifying the group in the address book

In the address book, you can specify the group to which you want to send a fax.

] Pressthe EXZ] tab to select the group to send a fax to.
Fax Settings oo e

Press Send button or START button.
Monitor

Destination 0007

ABC | DEF | GHI | JKL | MNO 1 % Q

Contents
Contents
Contents
Contents

Contents

Clear All Dest. & standard Option B Preview | Send |

Job Status

* To cancel the selected group, press it again.

* To confirm the fax number or the E-mail addresses registered in the group, press [Contents].

* To delete an unnecessary recipient, press it in the recipient list displayed on the left-hand side of the screen.

P.31 “Confirming/Deleting the recipients”

* To refine your search only for items including specified characters, press .

P.28 “Searching from the address book or LDAP server”

O Confirming/Deleting the recipients

You can confirm the recipients which you specified or delete unnecessary recipients.

1 Select the recipient to confirm from the recipient list displayed on the left-hand side of the

screen.
Fax Storage Settings ﬂ ® @

Press Send button or START button.
Dial

Destination 0001

ol User 001

Shared

ABC | DEF | GHI | JKL | MNO f ) Q

= User 001 sz r 002
- ser IE ser 002 I

0003 0003
User 003 User 003
o =

v

2004 0004 0005
& User 004 o |Jsor 004 & User 005

S Standard Optien B Preview <> Send

Job Status
Details of the selected recipient appear.

Tip

* Details of the members included in the group cannot be confirmed with this operation. Press [Contents] when

the group is selected.
P.31 “Specifying the group in the address book”
* Press [Clear All Dest.] to delete all recipients displayed in the list.
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2 Confirm the recipients on the screen displayed. Press [Clear] to delete the recipients or groups
from the recipient list.

Storage Settings ﬁ‘s_ @ 0

nd button or START button.
nation Detail

fax number.

, User
- 001

Job Status

When [Clear] is pressed, a confirmation message will appear. Press [OK].
The recipients selected are deleted from the recipient list.

H Displaying the preview before sending a fax
Before sending a fax, you can check the image on the touch panel with this preview function.

Tip
When dialing on-hook transmission or off-hook transmission, you cannot use the preview function.

1 Press [Preview] on the fax menu.
Fax Storage Settings o ® 0

Press Send button or START button.
Dial

ABC | DEF | GHI | JKL | MNO 1 % Q

0001 0002
(] User 001 B User 002
[

0002 0003 0003
User 002 User 003 User 003
] & =

0004 0004 0005 v
& ser 004 o | ser D04

Clear All Dest. 2 Ao 25 Standard &> send

Job Status

To use the preview function, press [Preview] before pressing [Send].

2 Specify the recipient and set the transmission conditions. Press [Send].

Fax
Press Send button or START button.

GHI | JKL | MNO 1 H Q

0002
&l User 002
(-

0002 0003 0003
] User 002 ] User 003
f

=| 0004 0004 0005
& User 004 o |ser 004 & User 005

Clear All Dest. B Auto 222 Standard Option

For details about how to specify the recipient and set the transmission conditions, see the references below:
[0 P.21 “Setting the transmission conditions”
P.27 “Specifying the recipient”
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3 Carefully check the displayed preview of your scans and the number of pages. To save or E-mail
your scans, press [OK].

Preview

To cor ess [START] button

&) Replace
oS page

Edit Cancel

* The number of pages of your scanned original is displayed on the upper right of the screen.

* If you want to scan another original continuously, place it on the original glass or in the ADF, and then press
the [START] button.

* When the page to confirm is selected, it is enlarged and the preview operation, such as the enlargement/
reduction of the display or the replacement/insertion of a page, becomes possible.

* To replace the page being previewed with another page, press [Replace Page], place a new original and press
[OKI.

* Toinsert another scan before the page being previewed, press [Insert Page].
* To delete the page being previewed, press [Edit] and then [ on the page to be deleted.
However, .1 is not displayed if only one page is being previewed.

* To change the setting, press [Option].
P.21 “Setting the transmission conditions”
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B On-hook transmission/Off-hook transmission

] On-hook transmission

You can dial and perform direct fax transmission without picking up the handset of the external telephone. On-hook
Transmission is available when on the upper right of the screen is OFF.

On-hook transmission using a 2nd line is not available.

1

2
3
4

Place the original(s).
P.14 “Placing an original”

Press [Fax] on the Home screen.

Set the transmission conditions.
P.21 “Setting the transmission conditions”

Press [Monitor].

Fax
Select contact.

Destination 0000
Shared

AlL | ABC | DEF | GHI | JKL | MNO f % Q

0001 00e1 0002
& User 001 User 001 User 002
o ] EE I

0002 0003 0003
User 002 User 003 User 003
] 4 ]

0004 0004 0005
& User 004 o | Iser 004 B User 005

2% Standard Option B Preview

Job Status

* Make sure that you hear the dial tone from the built-in speaker.

* To cancel the operation, press [Monitor] again.

When you specify the recipients by searching them, perform the next procedure in advance. In this case, specify
the recipients, and then press [Dial].

Specify the recipients.
P.27 “Specifying the recipient”

* Fordirect entry, press ﬁ to dial a number. If you make a mistake when dialing the fax number, press

[Monitor] to cut the line, and then press it again to redial.
* If you specified the recipient with the search, press [Dial].

When you hear the answer tone (short high-pitched tone) through the built-in speaker indicating
the connection has been made with the recipient’s machine, press [Send].
P.19 “Sending a Fax”

When you hear the other party’s voice answering the call before pressing [Send], pick up the handset of the
external telephone. Then ask him/her to perform operation of the fax reception.
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0 off-hook transmission

You can pick up the handset of the external telephone to dial and perform direct fax transmission. Off-hook

Transmission is available when on the upper right of the screen is OFF.

1

2
3
4

Place the original(s).
P.14 “Placing an original”

Press [Fax] on the Home screen.

Press [Option] and set the transmission conditions.
P.21 “Setting the transmission conditions”

Pick up the handset of the external telephone.

When you specify the recipients by searching them, perform the next procedure in advance. Press [Dial] after

specifying the recipients.

Use the external telephone to dial the fax number.
P.27 “Specifying the recipient”

* When you use the external telephone to dial, the machine dials each number you enter. If you make a mistake
when dialing the fax number, replace the handset to cut the line, and then pick up the handset again to redial.

* When you specify the recipients by searching them, press [Dial].

When you hear the answer tone (short high-pitched tone) through the built-in speaker indicating

the connection has been made with the recipient’s machine, press [Send].
P.19 “Sending a Fax”

When you hear the other party’s voice answering the call before pressing [Send], ask h
operation of the fax reception.

Replace the handset of the external telephone.

im/her to perform

Operating the Fax unit 35

(NOILYY3dO 21ISVYd) LINN XVd4 IHL ONISN



Receiving a Fax

M Originals and paper

QO Acceptable size of paper

A3, B4, A4, B5, A5, FOLIO, LD, LG, LT, ST and COMP sized paper are available.
The printing range of each size of paper is as follows: If an original contains any information outside of the printable
area, it is not printed on the paper.

* e-STUDIO6525AC Series: Leading edge 4.2 mm (0.17"), Trailing edge 3 mm (0.12"), Both edges 2 mm (0.08")
* e-STUDIO6528A Series: Leading edge 3 mm (0.12"), Trailing edge 2 mm (0.08"), Both edges 2 mm (0.08")
* e-STUDIO7527AC Series: Leading edge 4.2 mm (0.17"), Trailing edge 2 mm (0.08"), Both edges 2 mm (0.08")
* e-STUDIO9029A Series: Leading edge 3 mm (0.12"), Trailing edge 2 mm (0.08"), Both edges 2 mm (0.08")

When B5 size paper is used, set B4 size paper in another drawer.

Tip

* Set the paperin the drawers or the Large Capacity Feeder. The bypass tray is not available.

* Regardless of whether or not the Finisher is installed, paper exits on the receiving tray.

* Drawers can be set for fax use only. For details, see the reference below:
Preparation of Paper (e-STUDIO6525AC Series/e-STUDIO6528A Series) - LOADING PAPER - Doing Paper
Settings - Setting paper type
Preparation of Paper (e-STUDIO7527AC Series/e-STUDIO9029A Series) - LOADING PAPER - Doing Paper
Settings - Setting paper type

0O Default setting for Rx printing

To print the received fax, the paper with the same width as the original is used. Depending on the length of the
original, “Rx reduction printing” or “Discard printing” (both of them are set to ON by default) are applied.

For details about the setting Rx printing, see the reference below:

User Functions - SETTING ITEMS (Admin) - Fax - Setting Rx printing

When an original is shorter or the same as the paper printing area
Itis printed in the original size.

When an original is longer than the paper printing area
Itis printed according to the following priority:

* When an originalis up to 10 mm (0.4") longer than the printing area: the part of the originals that exceeds the paper
printing area is discarded.

* When an original exceeds the printing area by more than 10 mm (0.4"): the original image is reduced to 75 %
(reduction printing). If the image still cannot be fitted into the printing area, paper larger than the original is
selected. In case there is no larger paper available, the original is printed with the image divided.
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O Paper priority when there is no same size paper

When both “Rx reduction printing” and “Discard printing” are set to ON, paper is selected according to the following

priority:

1. Paper of the same size and the same orientation as the original

2. Paper of the same size but with a different orientation to the original
3. Paper of the same orientation but larger than the original

North American format

Size of Original
being Received |:|
Priority Ledger Legal Letter Letter Statement COMP
Ledger Legal Letter Letter Statement COMP
_____ T =
| 1
72 R R S L i
COMP Letter Letter Letter Ledger
_____ 3 : -
3 | |
Ledger Ledger Legal Letter Letter
I T oo - "1
4 - . -
Legal COMP Legal Letter
I | | ] T
5 . _: . _: - |
COMP Ledger COMP Legal
- "1
6 o
Ledger

* The selectable paper sizes differ depending on the models.

* When the corresponding paper size is not available, in most cases, the scanned original is printed on paper of a
larger size. However, the sender’s fax machine may reduce the scanned original to fit the paper size available in the
recipient’s fax machine (this equipment). (Ex. LD to LT)

* The paper priority varies according to the “Rx reduction printing” and “Discard printing” settings. For details,
contact your service technician.
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A/B format

Size of Original
being Received D |:| D D |:|
Priority A3 B4 A4 A4-R B5 A5 FOLIO
| O 0| o
A3 B4 A4 A4-R B5 A5-R FOLIO
2 IiEmEnE L] L]
A3 A4-R A4 B5-R A4-R B4
: ) S
A3 FOLIO B4 A4 A3
4
FOLIO B4 A4 FOLIO
B4 A3 A4-R B5
6 | J\ |- _‘
A3 B5-R
7 L _.
FOLIO B4
8 ]
A3

* The selectable paper sizes differ depending on the models.

* When the corresponding paper size is not available, in most cases, the scanned original is printed on paper of a
larger size. However, the sender’s fax machine may reduce the scanned original to fit the paper size available in the
recipient’s fax machine (this equipment). (Ex. A3 to A4)

* The paper priority varies according to the “Rx reduction printing” and “Discard printing” settings. For details,
contact your service technician.
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l Reception mode

This section describes how to receive a fax. Refer to the appropriate section for your current reception mode. The
reception mode can be set on the Admin menu. For details of the current setting, ask your administrator. Besides the
receiving methods described in this section, there are various useful ways to receive a fax. These procedures are
described in the references below:

P.51 “Communicating to a Request from a Recipient (Polling Communication)”

P.53 “Using the Mailbox Function”

Tip

Fax reception settings can be changed from TopAccess.
For details, see the reference below:
TopAccess - [Administration] - [Setup] Item List - Fax settings - Setting up Fax Setting

U Auto reception

Faxes are automatically received during an incoming call. Users do not have to do anything when receiving a fax.

Tip

When multiple fax units are installed, the reception mode of the 2nd line is limited to “Auto reception”.

U Manual reception

Faxes are manually received by using an external telephone when you have an incoming call.

1
2

Pick up the handset of the external telephone when you have an incoming call.
If the incoming call is a telephone call, you can start talking.

When you hear a tone (fax signal) through the handset of the external telephone, press [Fax] on
the Home screen.

Press the [Manual Rx].

Fax Settings

On hook transmit &1
Monitor

Destination Q000

Shared

Q)| AL | ABC | DEF | GHI UKL | MNO | F % Q

0001 0002 0003
&l User 001 & User 002 & User 003
- - ] |

0004
Bl User 004
¢ ]

2% Standard

Job Status

When a message indicating that you can receive a fax appears, press [Receive] on the touch panel
or the [START] button on the control panel. Replace the handset of the external telephone.

Fax
On Hook Receive
Monitor

Destination 0000

Local Shared

Q) | Al | ABC | DEF | GHI UKL [MNO £ D Q

0001 0002 0003
User 001 @ User 002 User 003
] - (o |

0084 0005 0006
B User 004 B User 005 B User 006
i (o (-

=%l Standard Option L Manual Rx
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O Memory reception

The received fax data are stored in the memory, the faxes are automatically printed as soon as the equipment
becomes ready. As the memory reception function is always enabled, you do not need to make any setting.

0 Displaying the preview of a received fax

You can confirm the contents on the touch panel before carrying out the printing of a fax received by means of the
[Hold (Fax)], [Secure Rx (Line 1)] and [Secure Rx (Line 2)] option.

1 Press [Print] on the Home screen.
The print screen is displayed. If you leave the screen unattended for the auto clear setting time (45 sec. by
default), the screen returns to the default one automatically.

2 Select [Hold (Fax)], [Secure Rx (Line 1)] or [Secure Rx (Line 2)] for Job Type.
If the equipment is running in the High Security mode, [Secure Rx (Line 1)] and [Secure Rx (Line 2)] are not
displayed.

Tip

* When E is pressed, received fax jobs are displayed in the list.
* To delete a received fax from the list, select the received file subject to delete and press [Delete].

When is pressed, received fax jobs are displayed in thumbnail images.

* To delete a received fax from the thumbnail, select the thumbnail image subject to delete and press [Delete].
* The entry of the password is required at the first operation of any of [Delete], [Print], [Display Image] or the
thumbnail images.

3 Press [Preview].

& Admin

Unchecked From Name @ Date,Time Paper Pages
o 10,09:49  A4-R

Delete All Clear & Print l

Job Status

4 Enter the password for printing secure receive fax jobs.
Tip

After the password is entered and then [OK] is pressed, | mark in the Unchecked field disappears. When the

screen is shifted to another one and then is returned to this one, the entry of the password is required when
preview or printing is carried out.
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5

When the preview is displayed, confirm the fax image and the number of pages. To printa
received fax as it is, press [Print]. Printing starts.

Preview

Uncheck the page not to print. Only checked page is printed.

05/10/2022,14:08

All Clear

* When a page to confirm is selected, it is enlarged and the preview operation, such as the enlargement/
reduction of the display or the rotation of the page, becomes possible.

* Press & on the page to be rotated. The page is rotated by 90 degrees by each one time |&] is pressed.

« Uncheck [l of the pages which will not be printed.

When printing is performed by specifying the page, the received fax is not deleted even if all pages are selected.
Print or delete the received fax on the screen in step 3.
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Checking Communication Status

H Checking reserved transmissions
You can check reserved fax transmissions.

1 Press [Job Status].

Fax

Select contact.
Destination 0000

Al

0001
il User 001
]

0002
- User 002

0004
B User 004

=% Standard

Print

File No

| @ All Pause Reservation List

Jobs Log

Shared

Settings ﬁ @ 0

Monitor

ABC | DEF | GHI | JKL MNO | ) Q

0001
- User 001
0003

User 003
9

000
— | Iser D04

Option

Supply

‘E User 002
ser
' 1

0003
-USer 003

Pages Status

Toner

Job Status

* Reserved transmission jobs are listed up to 100 transmissions in the chronological order from top to bottom.

* To print the list of the reserved transmissions jobs, press [Reservation List].

* Inthe “Status” column, the status of each job is indicated as follows:

- Linel: Sending on the 1st line.

- Line2: Sending on the 2nd line.

- Network: Reserved for sending via Internet Fax.

- Delayed: Reserved with the time to send specified.

- Wait: Communication is in the standby queue.

- Invalid: Under standby due to an invalid department code (Network Fax). Confirm the department code and
delete any unnecessary reserved transmissions in the standby queue. For each operation, see the

references below:

P.95 “Setting up the [Send] tab”

P.47 “Canceling reserved transmissions”

Tip

The 2nd line for FAX Unit is not available to some models.
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l Checking communication log
You can check the log of fax transmissions and receptions.

1 Press [Job Status].
Fax Storage Settings ﬂ @ 0

Select contact.

Monitor

Destination 0000
] Local Shared
&=

Q AW |ABC | DEF | GHL | KL (MNO F D |Q

2001 0001 0002
B User 001 User 001 User 002
(| = !=

0002 0003 0003
User 002 User 003 User 003
= A [ Rl

0004 0004 0005
B <er 004 o | l<or D04 B ser 005

S Standard Optien B Preview

2 Select the [Log] tab, and then press [Send] or [Receive].

Job Status

Date,Time Paper  Pages

A4-R

10,13:12

E!b 2Rl Toner

Job Status

Job Status

Send Receive

File No Date,Time Status

S -

Supply Toner

Job Status

* Transmissions or receptions are listed in the reversed chronological order from top to bottom.

* To print the log of transmissions or receptions, press [Journal].
P.75 “Journal (transmission journal/reception journal)”

¢ In the “Status” column, the status is indicated as follows:
OK: Transmission or reception succeeded.
4-digit error code: Transmission or reception failed.
For details about the error codes, see the reference below:
Frequently Asked Questions - QUESTIONS FOR ERROR CODES - Questions for Error Codes - Error codes on
transmission and reception
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* The Send and Receive logs can be downloaded to a USB storage device. For details, see the reference below:
User Functions - SETTING ITEMS (Admin) - General - Exporting logs

Registering recipients’ fax numbers to the address book
To register recipient’s fax numbers in the address book from the send/receive log screen, select a record in
the send or receive log, and then press [Entry]. For details of the registration to the address book, see the

reference below:
User Functions - SETTING ITEMS (User) - Address - Managing contacts in address book - Creating new

contacts

* Fax and E-mail transmissions whose recipients are specified with direct entry or entry using the LDAP
server can be registered to the address book from the Send log.

* Polling and E-mail receptions whose recipients are specified with direct entry or entry using the LDAP
server can be registered to the address book from the Receive log.
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Canceling the Transmission

l Canceling memory transmission job

You can cancel the memory transmission during scanning.

L When using the original glass

This section describes how to cancel the memory transmission when an original is placed on the original glass.

1 When scanning is completed, the confirmation screen for the next original is displayed. Press
[Job Cancel].

Scanning

To ¢

Job Finish | & scan

If you leave the screen unattended for a period of the auto clearance setting time (45 sec. by default) after the
confirmation screen for the next original is displayed, a copy of the scanned originals is sent.

2 The confirmation screen is displayed. Press [Yes].

Scanning

To continue, place doc,

Attention

Job Cancel Option JobFinish | | <> Scan
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O When using the ADF

This section describes how to cancel the memory transmission when originals are placed on the ADF.

Press [Stop] displayed on the screen while the originals are being scanned.
Scanning is paused.

2 The confirmation screen for the next original is displayed. Press [Job Cancel].

Scanning

Scan Page Original Size

2 A4

Job Cancel Option Job Finish & saan

¢ If you press [Job Finish], the scanned originals are sent.

¢ If you leave the screen for the next original unattended for the period of the auto clear setting time (45 sec. by
default) after it appears, the scanned originals are sent.

3 The confirmation screen is displayed. Press [Yes].

Scanning

Job Cancel Option JobFinish | D Scan
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H Pausing transmission
You can stop a transmission job during scanning.

Even if you cancel transmission in the direct Tx mode, the part of the original that was scanned before transmission is
canceled has been sent.

Press [Stop] displayed on the screen while the originals are being scanned.
The scanning and transmission are stopped.

H Canceling reserved transmissions

You can display the list of the reserved transmissions, and cancel the reserved transmissions that are in the queue or
in progress.

Press [Job Status], and then press [Fax].

The list of the reserved transmissions is displayed. This step is the same as that for checking the reserved
transmission.

P.42 “Checking reserved transmissions”

2 Select the reserved transmission you want to delete, and then press [Delete].
More than one job can be selected.

Job Status

File No Date,Time Pages Status

002 User 001 : 10,13:46 5 Wait

Jobs Toner

Job Status

In the “Status” column, you can check the status of the reservation. “Wait” indicates that the data are waiting to
be sent. “Linel” or “Line2” indicates that the data are being sent. Delayed transmission reservation and polling
transmission/reception can be canceled.

| @ AllPause Reservation List

3 The confirmation screen for the deletion is displayed. Press [Delete].

Job Status

Attention

Delete OK?

& All Pause
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USING THE FAX UNIT (USEFUL FUNCTIONS)
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Prioritizing Transmissions (Priority Reserve)

You can send a fax prior to other reserved transmissions (including redial standby).
Tip
Note that each setting will automatically return to its default setting when transmission is completed.

1 Place the original(s).
P.14 “Placing an original”

Press [Fax] on the Home screen.

P.21 “Setting the transmission conditions”

3 Set the transmission conditions.
4 Press [Option] > [Advanced] > [Priority Reserve].

Advanced

—_— a 1001 N
did |Somi B i Gpe

Priority Polling Polling ITU Mailbox
Reserve

Delayed Tx
Reserve

Recovery
Tx

Press [OK].

Specify the recipient’s fax number.
P.27 “Specifying the recipient”

o »n

Tip
In the priority transmission mode, you cannot specify multiple recipients’ fax numbers.

7 Press [Send].
P.19 “Sending a Fax”
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Communicating to a Request from a Recipient (Polling Communication)

The polling communication function allows you to receive pending originals in the sender’s fax machine by manually
operating the receiving fax machine. In this document, the operation in which this equipment is used as the sender’s
fax machine is called “polling transmission” while that in which it is used as the recipient’s fax machine is called as
“polling reception”.

l Storing data of originals in the memory (polling transmission)

Upon request of a recipient’s fax machine, this equipment sends an original document stored into the memory to the
recipient. By setting a recipient’s fax number to an original stored into the memory, you can permit specific recipients
to receive the original using the polling transmission.

1 Place the original(s).
P.14 “Placing an original”

Press [Fax] on the Home screen.

3 Set the transmission conditions.
P.21 “Setting the transmission conditions”

Press [Option] > [Advanced] > [Polling Reserve].

Advanced

r— PR oo %
doa | Gomi| B i {bw

Priority Polling y ‘
Reserve Reserve Polling ITU Mailbox

& @

Recovery
Tx

Chain Dial Delayed Tx
Comm. Reserve

5 If you set the fax number (the recipient’s telephone number), key in the number (maximum 20
digits), and then press [OK].

Polling Reserve

Fax Number 1234567890

If you don’t have to set the fax number, leave it blank and press [OK].

6 Press the [START] button on the control panel.
* Upon request of the recipient’s fax machine, the data of the original stored into memory are sent
automatically. Once they are sent, they are deleted from memory.

* You can delete the data of the original from memory by canceling the polling transmission.
P.42 “Checking reserved transmissions”
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H Requesting to send data of originals (polling reception)
This equipment requests the sender’s fax machine to send the data of the originals.

1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [Polling].

Advanced

—_—
# fiid R

Priority Delayed Tx
Reserve 5 Reserve

" 8

Recovery
Tx

3 Press [OK].

Polling

dest address

Cancel

4 Specify the sender’s fax number.
P.27 “Specifying the recipient”
Tip
This equipment supports two types of receptions: Individual polling reception in which you specify a recipient’s
fax number and Multi-polling reception in which you specify multiple recipients’ fax numbers.

5 Press [Send].
P.19 “Sending a Fax”

Tip
With the delayed transmission reservation, you can perform the polling reception on a specific date and time. To

do that, set the date and time before pressing [Send].
P.65 “Sending Faxes at Specified Dates and Times (Delayed Transmission Reservation)”

52 Communicating to a Request from a Recipient (Polling Communication)



Using the Mailbox Function

This function is used to communicate between fax machines compatible with a mailbox function (ITU-T compatible).
The owners of these fax machines can input or retrieve the data of the originals in the mailbox.

There are 3 types of mailbox: confidential mailbox, bulletin board mailbox and relay station mailbox. To perform
mailbox communication, the mailboxes must be created in advance. An individual password for each box can be set
for security protection.

P.59 “Creating, modifying, and deleting a mailbox (mailbox transmission)”

* Confidential mailbox
Once data of an original are retrieved from this mailbox, these data will be deleted. This mailbox is suitable for
registering an original you want to send to a specific recipient. If a new original is registered in this mailbox in which
another original exists, the mailbox will contain both of the originals.

* Bulletin board mailbox
No matter how many times an original is retrieved from this mailbox, the original will not be deleted. This mailbox
is suitable for registering an original you want to send to multiple recipients. If a new original is registered in this
mailbox in which another original exists, the existing original will be replaced with the new original and the new
one will be stored in the mailbox.

¢ Relay station mailbox
Using this mailbox, an original sent from a fax machine is relayed to pre-registered multiple recipients. To inform a
user of the result of the relay, a report called RELAY TX END TERMINAL REPORT can be sent to a specific recipient. A
copy of the original can be printed out (regularly or when an error occurs).

<Example of how to use the relay station mailbox>

If you want to send a copy of an original from an office in Los Angeles to multiple offices in New York, you first send
it from the one in Los Angeles to one of the offices in New York where the relay station mailbox is set up, so that it is
relayed to the other offices in New York. This will reduce communication costs.

(VIARELAY MAILBOX )

LA office Relay Originator --------- LA office
(213) (213)
|
| | | | . NY office A
NY office A NY office B NY office C NY office 0 Relay Station -------- (Relay Maiibox)
(212) (212) (212) (212)
S o E o~
* 4 long-distance calls Relay _:NY office B NY office C  NY office D

Destination ! (local) (local) (local)

* 1 long-distance call to the NY office A
(relay mailbox) and 3 local calls between
the NY office A (relay mailbox) and each
office.

Tip
If you create a forward mailbox whose number is the fax number of the sender, you can use the TSI function. Using
this function, this equipment forwards the original sent from the sender whose fax number is set to the mailbox
number, based on the pre-set agent (Save as File / Email / Store to e-Filing). This can be set from TopAccess. For
details, see the reference below:
TopAccess - [Registration] - [Registration] Overview - [Inbound FAX routing] Item list
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M Registering, printing, and deleting originals (mailbox transmission)
This section describes the operations of the mailbox in the equipment.

QO Registering originals
You can register originals to the confidential or bulletin board mailbox in the equipment.
Tip
To register the originals to confidential or bulletin board mailbox, the confidential or bulletin board mailbox must be

created in advance.
P.59 “Creating, modifying, and deleting a mailbox (mailbox transmission)”

1 Place the original(s).
P.14 “Placing an original”

Press [Fax] on the Home screen.

3 Set the transmission conditions.
P.21 “Setting the transmission conditions”

Press [Option] > [Advanced] > [ITU Mailbox].

Advanced

d il
Priority Polling Delayed Tx
Eleld Reserve Ce Reserve

" =N

Recovery
i

5 In the “Box Type” group, press [Confidential] or [Bulletin Bd.]. In the “Mode” group, press
[Input], and then press [OK].

ITU Mailbox

Box Delete

Transmit Polling

Cancel
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6 Key in the box number and then press [OK].

Confidential Input

Enter the box numbe

Box Number 001

Password /0 000000000080

Cancel

If a password has been set to the selected bulletin board mailbox, key in the password in the same way as the box
number. If you have selected the confidential mailbox, it is not necessary to key in a password since it is not
verified.

7 Press the [START] button on the control panel.
When you cancel the registration, press [Stop] displayed on the screen and then press [Job Cancel].

Q Printing originals

You can print the originals registered in the confidential or bulletin board mailbox in the equipment.

1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].

3 In t.he “Box Type” group, press [Confidential] or [Bulletin Bd.]. In the “Mode” group, press
[Print], and then press [OK].

ITU Mailbox

Confidential Bulletin Bd.

Cancel

4 Key in the box number.

Confidential Print

Enter the box number and password.

nber 001

ssword /0000000000000

Cancel

If a password has been set to the selected confidential mailbox, key in the password in the same way as the box
number. If you have selected the bulletin board mailbox, it is not necessary to key in a password since it is not
verified.
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5 Press the [START] button on the control panel.

U Deleting originals

You can delete the originals registered in the confidential or bulletin board mailbox in the equipment.
1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].

3 In the “Box Type” group, press [Confidential] or [Bulletin Bd.]. In the “Mode” group, press
[Cancel], and then press [OK].

ITU Mailbox

Confidential Bulletin Bd.

Box Setup Box Delete

Print Input

Transmit Polling

Confidential Cancel

Enter the box number

Box Number 001

If a password has been set to the selected mailbox, key in the password in the same way as the box number.

5 The confirmation screen for the deletion is displayed. Press [Yes].

Confidential Cancel

Attention

Are you sure ?
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l Sending and retrieving originals (mailbox transmission)
This section describes the operations to the mailboxes in the recipient’s fax machine.

Q Sending originals

You can send originals to the confidential/bulletin board/relay station mailbox in the recipient’s fax machine.

1

2
3
4

5

Place the original(s).
P.14 “Placing an original”

Press [Fax] on the Home screen.

Set the transmission conditions.
P.21 “Setting the transmission conditions”

Press [Option] > [Advanced] > [ITU Mailbox].

Advanced

d i
Priority Polling
Reserve Reserve

Chain Dial Delayed Tx

Polling ITU Mailbox T [

" =N

Recovery
T

In the “Box Type” group, press [Confidential], [Bulletin Bd.] or [Relay]. In the “Mode” group,

press [Transmit], and then [OK].

ITU Mailbox

Confidential Bulletin Bd.

Box Setup Box Delete

Print Input Cancel

C Polling

Reset Cancel
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6 Key in the box number and then press [OK].

Confidential Transmit

Enter the box number

Box Number 001

Password /O 900000000000

Cancel

If a password has been set to the selected mailbox, key in the password in the same way as the box number.
Tip

The box number and the password you specified here are sent to the recipient’s fax machine as SUD (box
number) and SID (password) of the command compatible with the ITU-T standards.

7 Specify the recipient’s fax number.
P.27 “Specifying the recipient”

8 Press [Send].
P.19 “Sending a Fax”

You can cancel the transmission of the original.
P.45 “Canceling the Transmission”

O Retrieving originals

You can retrieve originals from the confidential or bulletin board mailbox in the recipient’s fax machine.
1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].

3 In the “Box Type” group, press [Confidential] or [Bulletin Bd.]. In the “Mode” group, press
[Polling], and then [OK].

ITU Mailbox

Bulletin Bd

Input Cancel

i
Transmit Polling E

Reset
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4 Key in the box number and then press [OK].

Confidential Polling

Enter the box nt

Box Number 001

Password /0 000000000000

Cancel

If a password has been set to the selected mailbox, key in the password in the same way as the box number.

Tip
The box number and the password you specified here are sent to the recipient’s fax machine as SUD (box
number) and SID (password) of the command compatible with the ITU-T standards.

5 Specify the recipient’s fax number.
P.27 “Specifying the recipient”

6 Press [Send].
P.19 “Sending a Fax”

H Creating, modifying, and deleting a mailbox (mailbox transmission)
This section describes how to manage the mailbox in the equipment.
Tip
In the list, you can view the status of the mailbox registered to the equipment.
P.123 “MAILBOX/RELAY BOX REPORT”

0 Creating the confidential or bulletin board mailbox
You can create the confidential or bulletin board mailbox in the equipment.
1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].

Advanced

dog Gomt P | BF &

— —_— & )
Priority Polling Chain Dial Delayed Tx
Reserve Reserve eding Comm. Reserve

Recovery
Tx
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3 In the “Box Type” group, press [Confidential] or [Bulletin Bd.]. In the “Mode” group, press [Box
Setup], and then [OK].

ITU Mailbox

Confidential Bulletin Bd.

Cancel

Box Number 001

Password /0 000000000000

Cancel

If you want to set a password (a maximum of 20 digits), key in the password in the same way as the box number.
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O Creating/modifying a relay station mailbox
You can create or modify the relay station mailbox.

1 Press [Fax] on the Home screen.

2 Press [Option] > [Advanced] > [ITU Mailbox].

3 In the “Box Type” group, press [Relay]. In the “Mode” group, press [Box Setup] or [Modify], and
then [OK].

ITU Mailbox

Confidential Bulletin Bd.

4 Key in the box number (a maximum of 20 digits) and then press [OK].

Relay Box Setup

Enter the

Box Number 001

Password /0 000000000000

Cancel

If you want to set a password (a maximum of 20 digits), key in the password in the same way as the box number.

5 Specify the recipient to be registered, and then press [OK].
P.27 “Specifying the recipient”

Relay End Number

Shared

All | ABC DEF | GHI KL (MN » Q

0001 0002
er 001 - User 001 il User 002

(-

0002 0003 0003
User User 003 User 003

L] - ]

Clear All Dest.

Cancel

Specify the recipient from the address book because this cannot be done with direct dialing.
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6 The confirmation screen for sending a relay transmission report is displayed. If you want to send
the report, select [Yes]. If not, select [No].

Confirmation

Relay End Report

Tip
By default, the relay transmission end terminal report is sent when a communication error occurs. On the Admin
menu, you can make setting so that the report can be sent automatically. For details of the operation, see the
reference below:
User Functions - SETTING ITEMS (Admin) - List/Report - Setting the report - Setting the communication
report

7 Specify the recipient to which you want to send the report, and then press [OK].
P.27 “Specifying the recipient”

Relay End Terminal Report

| ac Shared

ABC | DEF | GHI = JKL 'MN )

Clear All Dest.

Only one recipient can be specified.

8 The confirmation screen for printing the received copy of the original is displayed. If you want to
print it out whenever a copy of the originalis delivered, press [Always]. If you want to print it out
only when an error occurs, press the [On Error].

Confirmation

Print Rx pages at rela

Cancel
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O Deleting a mailbox
You can delete the confidential/bulletin board/relay station mailbox registered in the equipment.
Tip
The confidential and bulletin board mailbox in which the original is registered cannot be deleted. To delete the

mailbox, delete the original in advance.
P.56 “Deleting originals”

1 Press [Fax] on the Home screen.
2 Press [Option] > [Advanced] > [ITU Mailbox].

3 In the “Box Type” group, press [Confidential], [Bulletin Bd.] or [Relay]. In the “Mode” group,
press [Box Delete], and then [OK].

ITU Mailbox

Cancel

Cancel

4 Key in the box number and then press [OK].

Confidential Box Delete

Enter the box number an

Box Number 001

Cancel

If a password has been set to the selected mailbox, key in the password in the same way as the box number.

5 The confirmation screen for the deletion is displayed. Press [Yes].

Confidential Box Delete

Attention

Are you sure ?
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Dialing numbers by Chaining Multiple Sets of Numbers (Chain Dial Communication)

You can chain pre-registered sets of numbers to form a dialing string. For example, you can form the desired number
by specifying sets of numbers registered in the address book sequentially such as region code, area code and fax
numbers.

1 Place the original(s).
P.14 “Placing an original”

Press [Fax] on the Home screen.

3 Set the transmission conditions.
P.21 “Setting the transmission conditions”

Press [Option] > [Advanced] > [Chain Dial Comm.].

Advanced

—_— > To01)
dea @t B i fbe
Priority Polling
Reserve E

" =N

Recovery
T

Delayed Tx

Polling ITU Mailbox e

5 Repeat this operation until the desired number is formed.
P.27 “Specifying the recipient”

You can form the dialing number which is up to 128 digits in length. The numbers are chained in the order you
specify them.

Tip
To send faxes to several recipients, press [OK] for each selection of a recipient to set the entry.

6 Press [Send].
P.19 “Sending a Fax”

64 Dialing numbers by Chaining Multiple Sets of Numbers (Chain Dial Communication)



Sending Faxes at Specified Dates and Times (Delayed Transmission Reservation)

You can send a fax at a specified date and time. It is useful when you want to make use of off-peak discounts (e.g.
nighttime) or you want to send a fax to a country which has a time difference.

1 Place the original(s).
P.14 “Placing an original”

Press [Fax] on the Home screen.

P.21 “Setting the transmission conditions”

3 Set the transmission conditions.
4 Press [Option] > [Advanced] > [Delayed Tx Reserve].

Advanced

e = D N
‘] i : )
Priority Polling Chain Dial Delayed Tx
Reserve Reserve Comm. Reserve

" =N

Recovery
T

Polling ITU Mailbox

Delayed Comm.

Enter the time

* The acceptable range of reservation is up to one month later.

* Specify the time on a 24-hour basis.

6 Specify the recipient’s fax number.
P.27 “Specifying the recipient”

7 Press [Send].
P.19 “Sending a Fax”

Canceling delayed transmission reservation

You can cancel the delayed transmission reservation and send a fax in a normal manner. On the reserved
transmission confirmation screen, select the transmissions job, and then press [Send].

P.42 “Checking reserved transmissions”
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Resending Unsent Data (Recovery Transmission)

You can save the data of originals, which were not sent after redialing a specified number of times, in the memory and
resend them without placing the originals. Enabling or disabling this function or a period of time for the data to be
retained can be set on the Admin menu. For the details of the current setting, ask your administrator.

1 Press [Fax] on the Home screen.

2 Set the transmission conditions.
P.21 “Setting the transmission conditions”

3 Press [Option] > [Advanced] > [Recovery Tx].

Advanced

r—
i £
Priority Polling ITU Mailbox

Reserve Reserve

" 58

Recovery
Tx

Recovery Tx
B 1234567890

File No Date, Time Pages

Job Cancel

* You can change the fax number which is specified with the direct entry method.

* To delete the selected transmission job, press [Job Cancel].
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E-mailing Data Received Via the Mailbox (Onramp Gateway)

The onramp gateway function allows for an original sent from another mailbox-supported fax machine to be
converted into E-mail data, which will be sent to a pre-registered E-mail address, via the mailbox (relay station) in this

equipment.

1. Afax is sent to the Relay Box
. of the equipment through the
ITU-T Compatible public telephone line.

G3 Fax machine

MFP
(this equipment)

Relay Box

2. The fax is converted to an E-mail
and sent to the E-mail address
registered in the Relay Box.

Mail Server

Mail Server

Internet Fax
machine

3. The E-mail (Internet Fax) is received
through the Network.

Internet
Intranet

Mail Server Client Computer

3. The E-mail is received through the
Network.

Fax numbers and E-mail addresses can be registered to the mailbox used for an onramp gateway transmission. That
mailbox is the same as the one used for the mailbox transmission. For details of how to create/modify/delete a relay

station mailbox, see the reference below:

P.59 “Creating, modifying, and deleting a mailbox (mailbox transmission)”

Tip

To use the onramp gateway, you need to set an E-mail address and Internet Fax to the equipment. For details, see the

references below:

TopAccess - [Administration] - [Setup] Item List - Email settings
TopAccess - [Administration] - [Setup] Item List - InternetFax settings
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Sending Data Received by E-mails Via the Mailbox (Offramp Gateway)

The offramp gateway function allows for E-mail or Internet Fax sent from another device to be converted into
standard fax data via this equipment, which will be sent to the recipient specified by the sender via a public telephone
line. This is useful in reducing communication costs by using a combination of both the Internet and public telephone
lines. For example, when sending documents long distances, such as overseas, the Internet can be used to send the
document to a machine in the country of destination and then it will be forwarded to a target fax machine as fax data
via a public telephone line.

3. The received E-mail and the Internet

1. The domain name of this equipment Fax are converted to the standard
and the fax number of the final 2. The E-mail and the Internet fax, and are sent to the final
recipient are specified and an Internet Fax in which the domain name recipient’s fax machine.

Fax is sent. of this equipment is specified

are received, and are sent to
this equipment.

Mail Server
MFP

Internet Fax @
machine

(this equipment)

Mail Server

Internet (SMTP)
Intranet %
J

Client Computer

g”bﬁddtr.ess G3 Fax machine
Mail Server estination
1. The domain name of this equipment
and the fax number of the final 4. If a subaddress is specified in the recipient of the
recipient are specified and an E-mail received fax, the fax is sent to the subaddress
is sent. destination.

Specifying an E-mail address
When you want to use this equipment as a relay station to perform an offramp gateway transmission, ask the sender
to specify an E-mail address as follows.

*  FAX=xxxxxxxx@FQDN
The fax number of the final recipient is specified in “xxxxxxxx”.
e.g.: In case that the fax number is “1234567890” and the domain name of this equipment (FQDN) is
“hostl.example.com”, the fax should be sent to
FAX=1234567890@hostl.example.com

Sending to a subaddress

o FAX=xxxxxxxx/T33S=yyyy@FQDN
The fax number of the final recipient is specified in “xxxxxxxx” and the subaddress in “yyyy”.
e.g.: In case that the fax number is “1234567890”, the subaddress is “1234”, and the domain name of this
equipment (FQDN) is “hostl.example.com”, the fax should be sent to
FAX=1234567890/T33S=1234@hostl.example.com

Setting up the SMTP server

SMTP is a server protocol for sending and receiving E-mails. To use the offramp gateway function, you need to set up
the SMTP server so that this equipment can receive E-mails and Internet Fax using SMTP. For details, see the reference
below:

TopAccess - [Administration] - [Setup] Item List - Network settings - Setting up SMTP Server
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Saving Transmitted Fax Data to the Shared Folder

While sending a fax, you can save the fax as a file to a shared folder in the equipment or in a client computer. That file
can be accessed from client computers on a network. To save a fax as a file into a shared folder in a client computer,
you must make the “Save as file” setting of the equipment in advance. For details, see the reference below:
TopAccess - [Administration] - [Setup] Item List - Save as file settings

* Be sure to back up the files in the shared folder to protect them from unexpected data loss events.
* Ifthe forced encryption function for PDF security* is enabled, this function is not available. For the details of the

wWwhN

security settings, see the reference below:
User Functions - SETTING ITEMS (Admin) - Security - Setting secure PDF

*  The PDF security may not be available depending on the equipment.

Place the original(s).
P.14 “Placing an original”

Press [Fax] on the Home screen and make settings as required.

Press [Storage].

Fax
Select contact.

Destination 0000

Shared

Q| Al

0001 @oo1
& User 001 - User 601
(EEs

0002 0003
User 002 User 003
] i

0004
o lser 004

0004
B User 004

=% standard Option

4 Select a file destination.

Save As File

File Format

MFP Local 3979626\FILE_SHARE\

POF

Remote 1

Multi/Single

Remote 2
Multi

DOCe81221
Single

Settings

ABC | DEF | GHI

Monitor

KL (MNO H Yy Q

L2U 00.
o
D |

0003
P User 003

0005
B User 005
B Preview
S

Job Status

e 0

* [MFP Local] — Press this button to store files in a shared folder of this equipment.

¢ [Remote 1], [Remote 2] — Press this button to store files in a network folder, which is the shared folder of a
computer connected with this equipment by network.

Storing data in a network folder requires the administrator to set the equipment configuration. For details, see

the reference below:

TopAccess - [Administration] - [Setup] Item List - Save as file settings - Setting up Destination
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Tip

* If saving data in a network folder is enabled by the administrator and if the file destination is specified by the
administrator, the network path for the destination is displayed on the right side of [Remote 1] or [Remote 2].
If the network path is not displayed, you need to specify a file destination. For details, see the reference below:
[ P.71 “Specifying the network folder”

* If saving data in a network folder is enabled by the administrator, you can select 2 file destinations from [MFP
Local], [Remote 1] and [Remote 2].

5 Make the settings for the files to be saved.

Save As File

File Format
MFP Local \WMFP13979626\FILE_SHARE\
PDF
Remote 1

Multi/Single
Remote 2
Multi

Single

* File Name
The file name can consist of a maximum of 128 characters. However, the trailing characters in a file name
(maximum 74) may be deleted depending on the type of letters used.

* File Format
- [PDF] — Press this button to store your scan as a PDF file.

- [TIFF] — Press this button to store your scan as a TIFF file. The OCR function cannot be used in this file
format.

- [XPS] — Press this button to store your scan as an XPS file. The OCR function cannot be used in this file
format.

- [DOCX] — Press this button to store your scan as a DOCX file. You can select this only when the OCR function
is enabled.

- [XLSX] — Press this button to store your scan as an XLSX file. You can select this only when the OCR function
is enabled.

- [PPTX] — Press this button to store your scan as a PPTX file. You can select this only when the OCR function
is enabled.

* Multi/Single Page

- [Multi] — Press this button to store your scan as a multiple page file. When you scan several pages, the
equipment stores all the pages as a single file.

- [Single] — Press this button to store your scan as a single file for each page. When you scan several pages,
the equipment stores each page as a separatefile.

e OCR
Press this button to enable or disable the OCR function.

Tip
* The data are saved in a shared folder with the file format which is set here.
When an OCR file format is selected, it is applied to only the data saved in a shared folder.
* When afile is saved in the shared folder of the internal storage device in the MFP, it is saved in the “TXFAX”

folder under the “FILE_SHARE” folder. When PDF-SINGLE, TIFF-SINGLE, or XPS-SINGLE is selected, another
folder with the same file name is automatically created in the “TXFAX” folder in which the file is saved.
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* Itis necessary to install the OCR option to use the OCR function. For the details of the OCR function, see the

reference below:

Scan - OVERVIEW - Scan Features - Scan functions - Optical Character Reader (OCR)

6 Specify the recipient’s fax number.
P.27 “Specifying the recipient”

7 Press [Send].
P.19 “Sending a Fax”

Tip

When fax transmission is completed, storing of the data of the original is also completed. However, if a fax cannot
be sent after redialing a specified number of times, only the storing of the data of the original is completed.

H Specifying the network folder

When you are authorized to specify a file destination for the network folder, specify the destination by setting the
following items. The setting items differ depending on the file transfer protocol to be used. FTP, SMB, NetWare IPX/
SPX, NetWare TCP/IP and FTPS are selectable for a file transfer protocol.

Storing data in a network folder requires the administrator to set the equipment configuration. For details, see the

reference below:

TopAccess - [Administration] - [Setup] Item List - Save as file settings - Setting up Destination

Tip

If saving data in a network folder is enabled by the administrator, you can select 2 file destinations from [MFP Local],

[Remote 1] and [Remote 2].

Q FTP/FTPS

Remote 1

Protocol
Server Name 10.10.70.101

Network Path user@1\scan

NetWareIPX Login User Name User01

NetWarelP Password 000000000000000000

FTPS _
Command Port

Cancel

When you finish the entry, press [OK].

* Server Name: Enter the IP address of FTP server. For example, if the data should be transferred to an FTP folder

“ftp://10.10.70.101/user01/scan/”, key in “10.10.70.101".

* Network Path: Enter a network path to an FTP folder where the data are to be stored. For example, if the data
should be transferred to an FTP folder “ftp://10.10.70.101/user01/scan/”, enter “user01l\scan”.

* Login User Name: Enter a user name to login to the FTP server. Enter this as required.

* Password: Enter a password to login to the FTP server. Enter this as required.

* Command Port: Key in acommand port number for executing commands. Normally

« »

is entered in this field,

which means that a port number set by the administrator will be used. Change this only when you want to use any

other port number.
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O SMB

Remote 1

SMB

NetWareIPX

NetWarelP

FTPS

When you finish the entry, press [OK].

* Network Path: Enter a network path to the folder where the data are to be stored.
* Login User Name: Enter a user name to access the network folder. Enter this as required.
* Password: Enter a password to access the network folder. Enter this as required.

Tip
If you selected [SMB], the settings for [Server Name] and [Command Port] are not required.

O NetWarelPX/ NetWarelP

Remote 1

Login User Name example.com

NetWarelP Password 000000000000000000

FTPS =
Command Port

Cancel

When you finish the entry, press [OK].

* Server Name: When you select [NetWarelPX], enter either the server name of NetWare server or Tree/Context (if
NDS is usable). When you select [NetWarelP], enter the IP address of NetWare server.

* Network Path: Enter a network path to a NetWare server folder where the data are to be stored. For example, if the
data should be transferred to a folder “sys\scan” of NetWare server, enter “\sys\scan”.

* Login User Name: Enter a user name to login NetWare server. Enter this as required.

* Password: Enter a password to login NetWare server. Enter this as required.
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Printing Secure Receive fax jobs

When the PRINT DATA lamp on the control panel is lit, there is a received Secure Receive fax job. You can print the fax
data by entering your Print Password.

This lamp does not light when the equipment is in the Super Sleep mode.

Tip
You can display the preview of the fax image received on the touch panel before printing the fax.
P.40 “Displaying the preview of a received fax”

1 Press [Print] on the Home screen.
The print screen is displayed. If you leave the screen unattended for the auto clear setting time (45 sec. by
default), the screen returns to the default one automatically.

2 Select [Secure Rx (Line 1)] or [Secure Rx (Line 2)]

L "
- Admin

Job Type
Refresh

No. Pages  Sets  Settings States

m chapter8_g Proof 2 1 B AaE mm

Invalid

Select All

Job Status

If the equipment is running in the High Security mode, [Secure Rx (Line 1)] and [Secure Rx (Line 2)] are not
displayed. [Secure Rx (Line 2)] is not displayed on some models.

3 Select the desired fax job and then press [Print].

e Al i
- Admin

Job Type Secure Rx (Line1)

Unchecked From Name Date Time Paper Pages

B - : 10.15:45  A4-R 1

Delete All Clear Preview &> Print ‘

You can select and print multiple fax jobs.
Tip

* When E is pressed, received fax jobs are displayed in the list.
To delete a received fax from the list, select the received file subject to delete and press [Delete].

* When is pressed, received fax jobs are displayed in thumbnail images.

* To delete a received fax from the thumbnail, select the thumbnail image subject to delete and press [Delete].

* The entry of the password is required at the first operation of any of [Delete], [Print], [Display Image] or the
thumbnail images.
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4 Enter the password for printing a received Secure Receive fax. Press [OK] to start printing.

Secure Receive Print Password
Enter Password.

Cancel
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Printing Lists and Reports

M Printing Lists & Reports Manually

You can print lists and reports (journals) manually. For samples of lists and reports, see the reference below:

P.117 “PRINTING LISTS AND REPORTS”

Tip

* Lists and reports are printed on LT/A4-size paper. If this equipment has run out of LT/A4-size paper, lists and

reports will be printed on larger sized paper.

* In addition to the lists described in this section, the following lists can be printed manually.

ADDRESS BOOK INFORMATION: List of recipients registered in the address book.

GROUP NUMBER INFORMATION: List of recipients registered in the address book as a group.

FUNCTION LIST: List of the user settings.
For details, see the reference below:
User Functions - SETTING ITEMS (User) - List

O Journal (transmission journal/reception journal)

You can print a list of transmissions and receptions.

Tip

This equipment logs up to the latest 40 or 120 transmission/reception records. This number can be set on the Admin

menu. For details, see the reference below:

User Functions - SETTING ITEMS (Admin) - List/Report - Setting the report - Setting the transmission / reception

journal output

1 Press [Job Status].
Fax Settings {'}.‘ @ 0

Select contact.

Moniter

0000
Local Shared

Q) AW | ABC | DEF | GHL | KL (MNO 1 D |Q

0001 o001 0002
i User 001 User 001 User 002
= = i |
0002 0003 0003
User 002 User 003 User 003
] 4 ]

0004 0004 0005
B User 004 — Iser 004 B lser 005

r—

2 Select the [Log] tab, and then press [Send] or [Receive].

Job Status

,

DateTime  Paper
11,13:04 A4-R
11,10:36 Ad4-R
11,10:36 A4-R
10, 18 Ad4-R

10,10:40

Supply Toner

Job Status
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3 Press [Journal].

Job Status

Print Send Receive Scan Application
File No Date,Time s Status
10,14:34

10,14:22 0 0052

Toner
Job Status

If [Journal] is pressed with the transmission/reception records selected, the journal of the selected file is printed.

0 Reservation list

You can print a list of the reserved transmissions.

1 Press [Job Status].
Fax Storage Settings ﬂ @ 0

Select contact.
Monitor

Destination 0000
Shared

QP | AWl | ABC | DEF | GHI | JKL MNO | ) Q

0001 0001 0002
@ User 001 User 001 User 002
(o ] ")
0002 0003 0003

User 002 User 003 User 003
[ ] a8 =

0004 0004 0005
B User 004 o {Jser Q04 B User 005

r—

S Standard Option B Preview

2 Press the [Fax], and then press [Reservation List].
Job Status

==

File No Date,Time Pages SETS

013 User 001 12,14:34 1 Linel

@ All Pause Reservation List

Supply Toner

Job Status
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B Printing Lists & Reports Automatically

You can print lists and reports automatically. For samples of lists and reports, see the reference below:
P.117 “PRINTING LISTS AND REPORTS”

Tip
Lists and reports are automatically printed according to the settings that the administrator made, so no user

operation is required. For details of the setting operation, see the reference below:
User Functions - SETTING ITEMS (Admin) - List/Report

The available lists/reports to be printed automatically are as follows:

TRANSMISSION JOURNAL
When this equipment completes 40 or 120 transmission jobs, the transmission journal is printed.

RECEPTION JOURNAL
When this equipment completes 40 or 120 reception jobs, the reception journal is printed.

MEMORY TRANSMISSION REPORT
When the memory transmission is completed, the report is printed. (You have an option to add a reduced image of the
transmitted document.)

TRANSMISSION REPORT
When the direct transmission is completed, the report is printed.

MULTI TRANSMISSION REPORT
When the multi-address transmission is completed, the report is printed. (You have an option to add a reduced image
of the transmitted document.)

MULTI POLLING REPORT
When a multi-polling Rx is completed, the report is printed.

RELAY TX ORIG. TERMINAL REPORT
When the document transmission from an originator terminal to a relay station is completed during the mailbox
transmissions, the report is printed. (You have an option to add a reduced image of the transmitted document.)

RELAY TX RELAY STATION REPORT
When a document transmission from a relay station to an end terminal is completed during the mailbox
transmissions, the report is printed. (You have an option to add a reduced image of the transmitted document.)

RELAY TX END TERMINAL REPORT

When the document transmission from a relay station to an end terminal is completed during the mailbox
transmissions, the report is sent to an originator terminal. (You have an option to add a reduced image of the
transmitted document.)

RELAY STATION REPORT
When a relay station in this equipment receives an original during the mailbox transmissions, the report is printed.

MAILBOX RECEPTION REPORT
When the confidential or bulletin board mailbox in this equipment receives an original during the mailbox receptions,
the report is printed.
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USING N/W-FAX DRIVER (NETWORK FAX)
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Overview of the Network Fax Features

This equipment provides the network fax features, which simplify and facilitate your office facsimile needs and
enables you to send fax or Internet Fax digital documents directly from your desktop.

* Fax transmission using the N/W-Fax driver is available only when the FAX unit is installed.
* Please enable the SNMP setting on TopAccess to use the N/W-Fax functions. In addition, the N/W-Fax driver does
not work if the SNMP setting on TopAccess is disabled when the optional FAX unit is installed.

The N/W-Fax driver and the AddressBook Viewer are the network fax utilities which are the client software of this
equipment.

The highly intuitive, N/W-Fax driver enables you to select the fax printer driver to electronically fax or Internet Fax
from your computer to one or more recipients. By the combination with the AddressBook Viewer, you can easily
manage a selection of fax recipients and access to the address book.

The N/W-Fax driver enables you to set up send lists and send electronic documents from your computer to one or
more destinations. You send to the fax in much the same way you would choose to print to a designated printer that
makes using the N/W-Fax driver quick and simple. You can select the fax properties. Fax properties are the attributes
you can set to define sender and recipient information for processing fax jobs such as dialing options, sender
information, fax resolution and page layout.

Other features include an easy-to-use fax scheduler that allows you to set up a date and time to transmit your fax.
Cover page options are also provided. You can include a customized cover page with your fax transmission that can
contain sender and recipient fax information and a detailed message. You can easily maintain sender and contact
information that can be printed on the cover pages.

Faxing paper documents must be performed by using the fax function from the touch panel of the MFP.

Tip

* Theimage quality of the originals that are sent by the N/W-Fax driver is different from the originals that are sent by
the general fax operation.

* If you specify the Email addresses as the recipients using the N/W-Fax driver, the document will be sent as an
Internet Fax. The Internet Fax feature allows users to send originals the same as the fax features. However, an
Internet Fax is sent through the Internet, although a fax is sent through the public switched telephone line. In order
to send an Internet Fax, the remote device also must support the Internet Fax feature.
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Sending Network Faxes

The basic procedure for sending a fax (Network Fax / Internet Fax) is as follows.

You can use standard functions or set optional functions as well as the basic ones described in this section. For these

operations, see the reference below:
P.93 “Setting up the N/W-Fax Driver”

1 Start the application software and prepare the document to be sent.

2 Select [Print] from the [File] menu in the application software.

Tip

The procedure for displaying the [Print] dialog box may differ from the above depending on the application

software.

3 Select [TOSHIBA e-STUDIO Fax] for the printer and click [Preferences].

General

Select Printer

rg =

Bk
S/
]

< >
Status: Ready [ Prirt to file
Location:
Comment Find Prinja 2
Page Range
[OF] Mumber of copies: |1 3
Selection Cumrent Page
11| 5)21] 33
Enter either a single page number or a single = 219l 3)
page range. For example, 512
Print Cancel Apply

@8 Print x

The dialog box of the N/W-Fax driver properties appears.

Tip

Note that the command name to open the driver properties may differ from [Preferences] depending on the

application software.

4 Click the [Send] tab and specify the recipients.

@ Printing Preferences

Send to
Address Bour....

To

x

Display Name Fax Number/Address

O Intemet Fax Address

Cover Sheet:

[E]] [ore -

— Select from —

Send Cover Sheet Only.
{0 [ Delayed Fax 8/12/2021 211 PM

™
s [lsaveasFie
TIFFMULT)

Restore Defautts

® oo —

Resolution , Department Code
2 =
Standard (200x 100 dpi) ~ o=l 2

Hide Department Code

OCR

Help
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* To specify recipients, enter them with the keyboard or select them from the address book.

P.84 “Specifying Recipien

ts of Network Faxes”

* Onthe [Send] tab, you can set the resolution of a fax cover sheet, etc. as well as specifying the recipients.
P.95 “Setting up the [Send] tab”

* On the [Layout] tab, you can set the size and the orientation of the paper.
P.94 “Setting up the [Layout] tab”

5 Confirm the recipients and

click [OK].

The transmission settings are determined and the N/W-Fax driver properties dialog box is closed.

6 Click [Print] in the [Print] dialog box.

2= Print

General

Select Printer

0 ika)
7
g

<

X

>

Status Ready OFrttofle
Location:
Comment Fingd Printer...
Page Range
®A Number of copies 3
Selection Curment Page
" R 1 52 5]
Enter etther a single page number or a single 1 2 3F
page range. For example, 5-12
Print Cancel Apply
Afaxis sent.
Tip

¢ Note that the command nam
application software.

e to print a document (send a fax) may differ from [Print] depending on the

* Awaiting fax job can be checked or deleted through the managing jobs function in TopAccess. A sent fax job

can also be checked through
below:

the displaying job logs function in TopAccess. For details, see the references

TopAccess - [Job Status] - [Job Status] Overview - [Fax/InternetFax Job] Item list
TopAccess - [Logs] - [Logs] Overview - [View Logs] Item list - Transmission Journal

l When password entry is required

When the [Enter the user credentials

manually] option is enabled on this equipment, you are prompted to enter your

user name and password before sending a fax.
When the dialog box appears, enter your user name and password, and then click [OK].

User Authentication

Enter user name and password.

User Name:

X

| UserD1

Password:

R1 =

Tip

* Upto 128 characters can be entered in the [User Name] box. Up to 64 characters in the [Password] box.
* The user name and password entered in the above boxes are not stored. Therefore, you must enter your user name
and password every time you send a fax.

* If you want to change the settings

of this option, carry it out on the [Device Settings] tab.

P.100 “Setting up the [Device Settings] tab”
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Hl When LDAP authentication is enabled

When LDAP authentication is enabled on this equipment, you must specify an LDAP server in the [Server Name] box on

the [Send] tab before sending a fax.

#=h TOSHIBA e-5TUDIO Fax Printing Preferences

Layout Send
Sendto
Address Book
To: Remaye
Display Name Fax Number/Address
< >
O Intemet Fax Address
Resolution , Department Code:
Standard (200 100 dpi) - [ |
Cover Sheet Hide Depariment Code
]| [Wore ~ Server Name:
Edt [ Select from — <]
. — Select from —
Send Cover Sheet Only RS
(L) [JDslayed Fax 8/12/2021 3:10 PM (§ [LDAPO3
;|
%y OsavessHe
TIFFMULTI) OCR
Restore Defautts Help

e | [ 53

If you attempt to send a fax without specifying an LDAP server, the [Specify LDAP Server] dialog box will appear to ask

you to do so.

In this case, specify the desired LDAP server in the [Server Name] box and click [OK] to send the fax.

Specify LDAP Server X
You have not selected any server for LDAP authentication.
Please select a valid server,

Server Name:

LDAPD1 A

Tip

If you want to change the settings of an LDAP authentication, carry it out on the [Device Settings] tab.

P.100 “Setting up the [Device Settings] tab”
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Specifying Recipients of Network Faxes

Up to 400 recipients can be specified in a single operation.
To send a Network Fax, specify the fax number. To send an Internet Fax, specify the Email address.

* If more than one recipient is specified in a single transmission, and a cover sheet is set in the N/W-Fax driver or a
header page is set to be printed on the recipient’s device, all the recipient information may be printed. If you want
to secure the recipient information, avoid sending a fax to multiple recipients at the same time.

* When you update the address book of this equipment, collect its data from AddressBook Viewer and synchronize
them to the latest status.

Tip

To use the address book, you need to register recipients in the address book of AddressBook Viewer in advance.

M Entering recipients from the keyboard
You can enter a recipient with the keyboard.

Select the entry method of a recipient to enter its fax number or Email address.
* Forthe recipient of a Network Fax, select the [Fax Number] check box and enter the fax number in the right-
hand box.

* Forthe recipient of an Internet Fax, select the [Internet Fax Address] check box and enter the Email address in
the right-hand box.

= TOSHIBA e-STUDIO Fax Printing Preferences x
Layout Send
Sendto
Address Book
To e
Display Name Fax Number/Address
< >
+
(@) Fax Number 12345697830 SUB/PWD...
O Intemet Fax Address
E Resolution: , Department Code:
Standard (200 x 100 dpi) ~ a=]
Caver Shest: Hide Department Code
(5]} [fione =
Ed — Select from —
_ N SNMP Settings
Send Cover Sheet Oy
L) [ Delaysd Fax 8/12/2021 2:06 PM o
g |
oy [JSaveasFie
TIFF(MULT ocR
Restore Defauits Help
c ovly
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Tip

«

e Use

- ” (hyphen) if you send a Network Fax with pauses (approx. 3 seconds) inserted in the fax number.

* When you enter a fax number, you can also enter a sub address and a password. Click [SUB/PWD] to enter
them (within 20 digits each) in the dialog box. Entering them enables the document to be transferred from the
recipient’s device to that of the sub-address, as the communication is in compliance with ITU-T standard.
However, in order to use this function, the recipient’s device must be a model in compliance with the ITU-T

standard.
SUB/PWD ®
SUB: PWD:
12364567890 123645678 | | 1234567890123456 7890 |

Cancel

Click L )

#=h TOSHIBA e-5TUDIO Fax Printing Preferences

Layout Send

Send to

Address Book...
To Remove

Display Name Fax Number/Address
12345697690 (SUB-12364567850123645678)PWD- 123456 7890123456 7¢

(@) Fax Number % SUB/PWD...

(O Intemet Fax Address

Resolution ., Department Code
Standard (200 x 100 dpi) ~ E||
Cover Shest: Hide Department Code
[E]] [ore =
Edi... — Select from —
SNMP Settings
Send Cover Sheet Only
{0 [ODelayed Fax 8/12/2021 2:06 PM Eg...
g |
2 [5aveasFie
TIFFMULTI) OCR
Restore Defauts Help

Conce | | tomy

The recipients selected for “To” are listed.

To send faxes to several recipients, repeat steps 1 and 2 to add the necessary fax numbers or Email addresses to

the list.

Tip

When the fax transmission is completed, the recipients are automatically removed from the “To” list.
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H Selecting recipients from the address book
Select recipients from the address book in the AddressBook Viewer.

1 Click [Address Book].

=h TOSHIBA e-STUDIO Fax Printing Preferences x

Layout Send

Send to

Address Book...

To Remove

splay Name Fax Number/Address

(@) Fax Number SUB/PWD

O Intemst Fax Address

Resolytion: -, Department Code:
=5
Standard (200 x 100 dpi) ~ o]
Cover Sheet Hide Department Code
[Zl]) [Nene -
it — Select from —
. SNMF Settings
Send Cover Sheet Only
{0) [Delayed Fax 8/12/2021 2:06 PM Edit
™,
s [saveasFie
TIFF(MULTI) ocR
Restore Defaults Help
oK Cancel Apply

The AddressBook Viewer runs.

Select a recipient from the contact list and add it to the list below.
* When selecting the recipient with the fax number, click [Select Fax].

* When selecting the recipient with the Email address, click [Select Email].

AddressBook Viewer — O *
File Edit Find View Tools Help
Ew
=-{E Address Book | Display Name | Fau Mumber Email Address
B Private Address Baok [ Ul ser 00 01234567590 1 ser_001 @example.c...
Bl Public Address Book [&]User 002 % 12345678901 User_O002@esample.c...
&-iE] P e ok ek @] 5er 003 23456783012 User_003@example.c...
L[;g;;“; d{:g'g BDD’:“ e [&]1)ser 004 24BE7BA0123 User_004@esample.c..
_ Impart Address Baak (@] Uzer 005 45678301234 Uzer_005@example.c...
< >
* Select Fax | * Select Email |
Selected Contacts: %,
Dizplay Mame | aTtio | Group Mame | Fax Mumber Email Address | ~
| Cancel Help
The total number of the contacts: 0/400

The selected recipients are listed in the “Selected Contacts”.
To send faxes to several recipients, repeat the above steps to add the necessary fax numbers or E-mail addresses
to the lists.

A contact, for which only a fax number is registered, cannot be displayed in the “Email Address” and a contact, for
which only an Email address is registered, cannot be displayed in the “Fax Number”.
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You can select a recipient by the following operations:

¢ Selecting a contact by dragging and dropping
Drag a contact in the contact list and drop it to [Selected Contacts] and then select [Fax Number] or [Email
Address] from [Select].

¢ Selecting a contact by double-clicking on it
Double-click on a contact in the contact list. Since [Email] is set as the factory default, only the Email address
of the recipient selected by double-clicking on a contact is displayed in “Selected Contacts”. To change the
setting of the recipient to be selected upon double-clicking, select [Default Configuration], [Type Selection] in
the [View] menu and then one of [Fax], [Email] and [Both].

¢ Selecting a contact from a shortcut menu
Right-click on the contact in the contact list, select [Select] from the shortcut menu and then either [Fax
Number] and [Email].

* Removing arecipient
Select a recipient in the “Selected Contacts” and click [Remove].

3 Confirm the recipients and click [OK].
The AddressBook Viewer is closed and the recipients selected for “To” are listed.
Tip
When the fax transmission is completed, the recipients are automatically removed from the “To” list.

H Selecting recipients from the address book (Search option)
You can find and select a recipient from the address book in the AddressBook Viewer.

1 Click [Address Book].

=h TOSHIBA e-STUDIO Fax Printing Preferences x

Layout Send

Send to

splay Name Fax Number/Address

(®) Fax Number SUB/PWD.
O Intemst Fax Address

Resolution: ., Department Code:

= =
Standard (200x 100 dpi) ~ o=
Cover Sheet Hide Department Code
[Zl]) [Nene S
Ed — Select from —
- - SNMP Settings
Send Cover Sheet Only
{ &) [ Delayed Fax 8/12/2021 2:06 PM di
.
o [JSaveasFie
TIFF(MULTI) ocR
Bestore Defaults Help
oK Cancel Aoply

The AddressBook Viewer runs.
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2 Click the [Find] menu.

AddressBook Viewer — O *
File | Edit Find View Tools Help
@ Copy Cirl+C
Paste Ctrl+V
G- Display Name | Fax Mumber | Email &ddress |
Sl G o] User 001 01234567830 User_001 @example.c...
VR 1 ser 002 12345570901 |ser_N02@example.c...
sl adcrecs Book ] 1 ser 003 2356729012 1 ser_N03@example.c...
| ! 5 ':SS oo ] User D04 34567890123 User_DD4@esample.c
ress Bool =
(+1-[ 7 Import Address Book T ] User D05 4567B301234 User_005&example.c...
< >
~ Select Fax | ~ Select Emall
Selected Contacts:
Display Mame | aTio | Group Mame | Fax Nurmber Email Address |
Cancel Help
Search for contacts The total number of the contacts: 5/2000

The [Find Contact] dialog box appears.

3 Select an address book in [Data Source].

Find Contact X

DataGouce: | Public Addiess Book =]

. |All Addiess Book
Person ] Detail 55 Private Address Boak.
Lblic Address Book

MAPI Addriess Book,

Display M :
Srazas “windows Mail Address Book

Fax Mumber: |

Email: |

Furigana: |

Search

Group Mame | Digplay Name | Fax Mumber ‘ Email Address ‘ Furic
£ >

Selected Contacts:

Display Mame | aTin | Group Mame | Fax Mumber Emall &ddiess

Cancel Help

Tip
To change the setting of the default address book in the [Data Source] box, select [View] - [Default Configuration]
- [Data Source] and then choose an address book.
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4 Display the [Person] tab and enter search strings in the following boxes.

Find Contact *
Data Source: |F'ub|ic Addiess Book ﬂ
Pelsml&taﬂ Setting ]
Display\Yame: | Person|
Fax Number: [
Email: |
Furigana: |
Seaich
Group Mame | Display Marne | Fax Nurmber ‘ Email &ddress ‘ Fuiric
< >
Selected Contacts:
Display Mame | aTiC | Group Mame ‘ Fa Mumber | Email Address |
| Cancel | Help |

* Display Name — To search display names, enter a search string here.
e Fax Number — To search fax numbers, enter the numbers here.

¢ Email — To search Email addresses, enter a search string here.

If you perform searching in the above conditions, proceed to step 6. If you want to set more detailed search
conditions, proceed to step 5 and set them in the [Detail Setting] tab. However, note that even if you enter the
search conditions in both the [Person] and [Detail Setting] tabs, you cannot perform searching in this
combination at one time.

Tip
In the [Person] tab, you do not have to fill in all the boxes and the string does not need to completely correspond

to the target of the search. Entering one or more characters in one or more boxes causes a search to be made for
contacts which correspond to the particular conditions.
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5 Display the [Detail Setting] tab, set the search conditions, and then click [Add].

Find Contact *
Data Source: |F'ub|ic Addiess Book ﬂ
Person  Detail Setting
Define Condition: 1
Field Select: Condition of search string:
|D\splay Name ﬂ |CDntains j |L|SEI'|
Condition list: h o
N Add
3| s |
Group Mame | Display Marne | Fax Nurmber ‘ Email &ddress ‘ Fuiric
< >

Selected Contacts:
Display Mame | aTiC | Group Mame ‘ Fa Mumber | Email Address |

=TT

| Cancel | Help

¢ Field Select — Select an item to be searched.

* Condition of search string — Select a condition in the left-hand box, and then enter a search string in the
right-hand box.

The search condition is displayed in the “Condition list”.
To set more than one search condition, repeat this operation as many times as needed.
To delete the search conditions, select one and click [Remove].

6 Click [Search].

Find Contact >

Data Source: |F'ub|ic Address Book, ﬂ
Person Detail Setting }

Define Condition:

Field Select: Condition of search string:
|D\sp|a\; MName ﬂ |Cnntains ﬂ |
Condition list:

Display Name Contains User | |

Group Mame | Display Mamne | Faux Mumber ‘ Email Address ‘ Fuiric
£ >
Selected Contacts:
Display Mame | aTin | Group Mame | Fax Mumber Emall &ddiess
| Cancel | Help |

It starts searching contacts in the selected address book. When the search is complete, the contacts matching the
search conditions are listed.
To stop searching, click [Stop].

Even if you enter the search conditions in both the [Person] and [Detail Setting] tabs, only the search conditions
in the tab currently displayed is used. You cannot perform searching in the combined conditions on both tabs.
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7 Drag and drop the contacts to “Selected Contacts” from the list of the search results.

Find Contact *
Data Source: |F'ub|ic Addiess Book ﬂ
Person  Detail Setting 1
Define Condition:
Field Select: Condition of search string:
|D\splay Name ﬂ |CDntains ﬂ | |
Condition list:
Display Name Containg User |
Seach |
Group Mame | Display Name | Fax Mumber ‘ Email Address ‘ Fa
Group003 User 001 (1234567890 User_001 Eexample.com
GroupO0l Uger 001 012345678: = ]
Group005 User 002 1234 il User_002exar am
1l ear NMT7 1 i llear MN@awamnla ~om v
)
Selected Contacts:
Display Mame | aTiC | Group Mame ‘ Fa Mumber | Email Address |

| Cancel | Help

Select of [Fax Number] or [Email Address] from [Select].
The selected recipients are listed in “Selected Contacts”.
To send faxes to several recipients, repeat steps 1 through 8 to add the necessary fax numbers or Email addresses

to the list.

A contact, for which only a fax number is registered, cannot be displayed in the “Email Address” and a contact, for
which only an Email address is registered, cannot be displayed in the “Fax Number”.

You can select a recipient by the following operations:

* Selecting a contact by double-clicking on it
Double-click on a contact in the list of the search results. Since [Email] is set as the factory default, only the
Email address of the recipient selected by double-clicking on a contact is displayed in “Selected Contacts”. To
change the setting of the recipient to be selected upon double-clicking, select [Default Configuration], [Type
Selection] in the [View] menu and then one of [Fax], [Email] and [Both].

¢ Selecting a contact from a shortcut menu
Right-click on the contact in the list of the search results, select [Select] from the shortcut menu and then
select either [Fax Number] or [Email].

* Removing a recipient

Select a recipient in the “Selected Contacts” and click [Remove].

9 Confirm the recipients and click [OK].
The AddressBook Viewer is closed and the recipients selected for “To” are displayed on the list.

Tip

When the fax transmission is completed, the recipients are automatically removed from the “To” list.
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B Removing recipients

You can remove a recipient from the “To” list in the N/W-Fax driver properties.

1 Select a recipient and click [Remove].

i TOSHIBA e-STUDIO Fax Printing Preferences K

Layout Send

B ©rthnee E—
(O Intemet Fax Address [ |
con. === Department Code:
E | Standard (200 100 dpi) ] | |
Cover Sheet [ Hide Department Code
M Server Name:
=
["] Send Cover Sheet Orlly \ SNMP Settings... |
(D Dpelayed Fax [2/12/2021 208 PM T
2 OSaveas Fie File Format
[FrETETE ock

[Cok | cencel || most |

The selected recipient is removed.
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Setting up the N/W-Fax Driver

There are two ways to set the N/W-Fax driver options: One is to make the initial settings of the options and the other is
to set each option for each individual job.

l Making the initial settings of the N/W-Fax driver options
Setting the N/W-Fax options by displaying the N/W-Fax driver properties from the Printers folder on the Windows
[Start] menu will establish the initial settings of the options.

1 Click [Start] and select [Settings] > [Devices] > [Devices and printers].
When using Windows Server 2012, right-click in the lower left of the screen, then click [Control Panel] > [Devices
and Printers].

2 Right-click [TOSHIBA e-STUDIO Fax], and then select [Printing preferences] or [Printer
properties] from a shortcut menu.
If [File] menu is not displayed, press [Alt].

Hl Setting print options for each print job

Setting the N/W-Fax driver options by displaying the printer properties from the [Print] dialog box within an
application will establish the settings for the current N/W-Fax job. The N/W-Fax driver option settings specific to each
N/W-Fax job are set using this method.

1 Click the [File] menu and select [Print] on an application.
2 Select [TOSHIBA e-STUDIO Fax] and click [Properties] or [Preferences].
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Setting up the N/W-Fax Driver Options

You can make the settings for the N/W-Fax driver options. For example, you can specify the recipients, resolution, and
paper size.

H Setting up the [Layout] tab

On the [Layout] tab, you can set the size and the orientation of the paper.

=8 TOSHIBA e-STUDIO Fax Printing Preferences *
Layout | Send

1 . Orienitation:

Portrait -

Adyanced. ., ——

cancel | | 200

1. Orientation
Set the printing orientation of the document.
- Portrait — Data are printed vertically to the paper.
- Landscape — Data are printed horizontally to the paper.

2. [Advanced]
Click this to display the [Advanced Option] dialog box. You can select the paper size of the document.

Fax Advanced Options *®

“g} Fax Advanced Document Settings
(=44 | Paper/Output

94 Setting up the N/W-Fax Driver Options



l Setting up the [Send] tab

In the [Send] tab, you can specify the recipients and how the fax will be sent.

= TOSHIBA e-STUDIO Fax Printing Preferences *
Layout Send
Sendto
1 — Address Book.
2 1, 3
Display Name Fax Mumber/Address
44— 5, @ Fax Number SUB/PWD.. -_5
6 O Intemet Fax Address
T— Rsel:il:(zm, 100 dpi) - d|Depanmem re————8
Cover Sheet: [ Hide Departmert: Code mmmmme Q)
10 ——[=]) [1ore ~ 12
1 Ed — Select from —
Send Cover Sheet Orlly L S setine: —13
14——\9 [ Delayed Fax 8/12/2021 2:06 PM Edt...
15 —— % [saveasie 16
TIFF(MULTI) e e V4
18 —— Restore Defauts Help —_—19
oK Cancel Apply
1. [Address Book]
Click to launch the AddressBook Viewer. You can select recipients from the address book.
P.86 “Selecting recipients from the address book”
2. To
This displays the specified recipients list.
P.84 “Specifying Recipients of Network Faxes”
3. [Remove]
Select a recipient in the [To] list and click this to remove the recipient from the list.
P.92 “Removing recipients”
4. Fax Number
Enter the recipient’s fax number directly.
P.84 “Entering recipients from the keyboard”
5. [SUB/PWD]
Click this to display the [SUB/PWD] dialog box. You can add a sub address and a password to the entered fax
number.
P.84 “Entering recipients from the keyboard”
6. Internet Fax Address
Enter the recipient’s Internet Fax number directly.
P.84 “Entering recipients from the keyboard”
7. Resolution
Select the resolution for the fax.
- Standard (200 x 100 dpi) — Select this to send a document in Standard mode (200 x 100 dpi).
- Fine (200 x 200 dpi) — Select this to send a document in Fine mode (200 x 200 dpi).
- Super Fine (200 x 400 dpi) — Select this to send a document in Super Fine mode (200 x 400 dpi).
- Ultra Fine (400 x 400 dpi) — Select this to send a document in Ultra Fine mode (400 x 400 dpi).
8. Department Code

Enter a department code of 1 to 63 characters if required. When the department code is enabled on the MFP, you
must enter it to send a fax.
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10.

11.

12.

13.

14,

15.

16.

17.

18.

19.

* Ifyou do not enter a department code when it is enabled on the MFP the [Invalid Department Code Print Job]
is set to “Store to invalid job list” in TopAccess, the job will be stored in the Invalid job list without being
transmitted. You can print or delete a stored job from the [Job Status] on the touch panel.

* If you do not enter the department code when the department code is enabled on the MFP and the [Invalid
Department Code Print Job] is set to PRINT in TopAccess, the job will be sent.

* If you do not enter the department code when the department code is enabled on the MFP and the [Invalid
Department Code Print Job] is set to DELETE in TopAccess, the job will be deleted automatically.

Hide Department Code
Select this check box to display a department code in the hidden symbols.

Cover Sheet

Select a cover sheet type among [Standard Cover Page], [Business Cover Page], [Professional Cover Page] and
[My Cover Page] if you want to attach a cover sheet to the first page of the document.

P.106 “Sending with a cover sheet”

[Edit]

Click this to display the [Cover Sheet Settings] dialog box. You can perform various kinds of editing on the cover
sheet selected in the Cover Sheet setting, such as entering a subject or a message, or changing the type or size of
the fonts.

P.97 “Setting up the Cover Sheet”

Send Cover Sheet Only
Select this check box to send a cover sheet only.

Server Name
Select the desired LDAP server in the [Server Name] box if needed.

Tip
You can make settings for the LDAP server on the [Device Settings] tab.
P.100 “Setting up the [Device Settings] tab”

[SNMP Settings]
Click this to check or change the SNMP settings.
P.98 “Setting up the SNMP”

Delayed Fax

Select this to send a document at a specified date and time. When this is selected, click [Edit] to display the
[Scheduled Time] dialog box and specify date and time the job will be transmitted. The job sent to the MFP will be
stored in the Fax queue until the specified date and time.

P.105 “Delayed transmission reservation”

Save as File

Select this to save documents in the “file_share” folder in the MFP as well as send the document as a fax and
Internet Fax.

P.104 “Saving a fax as a file”

Tip
* When the cover sheet is set, the cover sheet and the original will be stored in the “file_share” folder.

* The maximum capacity in the shared folder differs depending on your model or operating environment. The
total available space in the shared folder and e-Filing can be checked on the [Device] in TopAccess.

File Format
Select the file format of the document that will be saved. This option can be selected only when the [Save as File]
check box is selected.

OCR
Select this check box to enable the OCR function. This option can be selected only when the [Save as File] check
box is selected.

[Restore Defaults]
Click this to restore the settings to make the equipment as it was at the time of factory shipment.
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20. [Help]
Click this to browse Help for the N/W-Fax driver.

l Setting up the Cover Sheet

You can set the content of the cover sheet to be attached to a fax.
P.106 “Sending with a cover sheet”

Emoji is not available for a cover sheet.

Cover Sheet Settings X
Cover Sheet Name:
[ FACSIMILE TRANSMITTAL | Standard Cover Page
Header Text
| FACSIMILE TRANSMITTAL| _— 6
|
Text Area Details
1 [ Reference Mumber 7
[JRecipients Information 8
MName Company
Department Name Fax Number
2 — Detal Format [[]sender Information 9
3 — Large Preview
4 — Fonts
Font for:
Header ~ Edit...
[ subject 10
5 Footer
Image File:
|:| Browse... [message 11
o] Ji=]] 0]
1 2 — Restore Defaults
Please note that Emaji cannot be used for the Cover Sheet. Cancel Help

1. Preview
The image of the cover sheet can be previewed. You can check the layout of the character strings and images.

* Depending on the line feed positions, the preview may not duplicate the actual print result of the cover sheet,
but is used for checking its layout.
* Ifthe contents are on more than one page, such as the many line feeds included in “Sender Information” or
“Message”, only the first one page is displayed in the preview.

[Simple Format]/[Detail Format] switch button

Switch the display format for the description of the sending information on the cover sheet. By selecting [Detail
Format], ruled lines appear. By selecting [Simple Format], no ruled lines appear.

[Simple Format] is set as the default. [Detail Format] is displayed on the button.

[Large Preview]
Click this to display the cover sheet on another screen. You can enlarge the preview or display another page when
there are multiple pages.

Fonts
Select the font to be used for the cover sheet. Select the section for which the font is used, and then click [Edit] to
select the type, style and size of the font.

- Header — Set the font to be used for the header of the cover sheet.

- Title — Set the font to be used for the title such as Reference Number, Recipients Information, Sender
Information, Subject or Message.

- Body — Set the font to be used for the body of each title.
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5. Footer
Select an image file to be attached to the footer of the cover sheet.

- [Browse] — Click this to select an image file to be attached to the footer within 1 MB.

- [Delete] — Click this to delete the attached image file.
- Position — Select the position of the image file from the left, center and right.

6. Header Text
Enter a title to be displayed on the header of the cover sheet; it can be up to 63 characters.

7. Reference Number
Check this to have a reference number identifying the fax to appear on the cover sheet. Enter the reference
number in the text box.

8. Recipient’s Information
Check this to have the recipient’s information appear on the cover sheet. Select the desired information among
the options below.

- Name — Check this to have the recipient name appear on the cover sheet.

- Company — Check this to have the recipient company name appear on the cover sheet.

- Department Name — Check this to have the recipient department name appear on the cover sheet.

- Fax Number — Check this to have the recipient fax number or Email address appear on the cover sheet.

9. Sender Information
Check this to have the sender’s information appear on the cover sheet. You can enter the information in up to 500
characters.

10. Subject
Check this to have a subject appear on the cover sheet. You can enter the subject in up to 40 characters.

11. Message
Check this to have a message appear on the cover sheet. You can enter the message in up to 500 characters.

12. [Restore Defaults]
Click this to restore the settings to make the equipment as it was at the time of factory shipment.

H Setting up the SNMP

If the recipient’s MFP is not found over the Internet and the fax job is not sent normally, the SNMP settings may be the
cause. Check that the SNMP settings are correct in the [SNMP Settings] dialog box, and if not, change them.

Ask the administrator for details on the SNMP Network settings configured for your MFP.

SNMP Settings X

1 —— - \ersion

& vz 3 '@
2 ———— suvPvIN2

Community Name:

|pnvahe
3 ———swweus

=

)

[

[FMac-mDs =

|Hc-ne J
4 ———— | Hestore Befadit oK Cancel
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Version

Be sure to have the correct SNMP version set for your MFP and select from the following options:

- V1/V2 — Select this option to enable SNMP V1 and V2.

- V3 — Select this option to enable SNMP V3.

- V1/v2/v3 (for [Discovery Settings] dialog box only) — Select this option to enable SNMP V1, V2, and V3.

SNMP V1/V2
Community Name — If a community name other than “private” (default) is set for the SNMP community name
for your MFP, enter its community name.

* To send fax jobs normally under an SNMP V1/V2 environment, the SNMP community names must be the same
in the 3 settings shown below. For details, ask your administrator.

- Your MFP
- [SNMP Settings] dialog box of the [Send] tab
SNMP Settings X
Version
& vz w3 =

SNMP W1/v2

Community Name:

| private

SNMP V3

(Xv4 Y4OMLIN) 4IAINA XV4-M/N ONISN

- [Port Settings] tab in the N/W-Fax driver

Cenfigure Standard TCP/IP Port Menitor x
Port Settings
Port Name: |192‘168.D.TD
Printer Name or [P Address: |192‘1ES.D.WD
Protocol
& Rew CLPR
Raw Settings
Port Number: ‘ 9100
LPR Settings
I=
[v_SMMP Status Fnabled
Community Name: ‘ private|
SMMP Device Index: ‘ 1
Cancel

* To change the community name, the administrator privilege is necessary. You must log in with the
“Administrator” privilege and open the printer driver properties.
* Upto 31 characters including the following symbols can be entered for the Community Name.

P"#S%& () +,-/5<=>2@[\]1"_ " {[}~

SNMP V3

If SNMP V3 is enabled, select one of the following items to set how users are authenticated.

User ID File — Select this option when you want to use a user ID file. Click [Browse] and specify the user ID file.
User Name/Password — Select this option when you want to use the user name and password. When this option
is selected, enter or select the following items:

- User Name

- Authentication Protocol
- Authentication Password
- Privacy Protocol

- Privacy Password
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* If you select to enable SNMP V3, consult your network administrator for preliminary advice on how to
authenticate users.

* Upto 31 characters including the following symbols can be entered for each of the User Name, Authentication
Password and Privacy Password.

1$%&'()-,<>@[]1"_" {}~

* This function is not available when your computer and MFP are connected with a USB cable.

4. [Restore Default]
Click this to restore the settings to make the equipment as it was at the time of factory shipment.

l Setting up the [Device Settings] tab

On the [Device Settings] tab, you can change a setting for N/W-Fax driver update or display the software version of the
driver.

Ask the administrator for details on the settings configured for your MFP.

= Properties X
General Shaing Pots  Advanced Color Management Securty Device Seftings

1 — | Indate Automatically

On ~
2 e Useer Authentication

Off - Details... —_— 3
4 s | | Eniteer the: user credentials manually
5 e P Function

Enabled ~
6 —— |temet Fax Function

Enabled ~
7 ———— IP Fax Function

Disabled ~
8 ———— Cover Sheet confimation

Enabled ~
9 — Customization

1 o_— Version Information...
Cancel Apply Help

1. Update Automatically
Select whether or not the setting information of each item on the [Device Settings] tab of the N/W-Fax driver is to
be obtained by automatically communicating with your MFP every time this tab is opened.

- On — Select this to obtain the setting information automatically.
- Off — Select this not to obtain the setting information automatically. Set each item manually.

This function is not available when your computer and MFP are connected with a USB cable.

2. User Authentication
Select the authentication method which is to be used. Set it to correspond to that of your MFP.

- Off — Select this not to perform user authentication.

- MFP Local Authentication — Select this to perform MFP Local Authentication.

- Windows Domain Authentication — Select this to perform Windows Domain Authentication.
- LDAP Authentication — Select this to perform LDAP Authentication.

Tip

If the user authentication and project code are enabled in the equipment, you need to enter the project code
when sending the fax.
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3. [Details]
The [LDAP Server Settings] dialog box will appear. This option can be selected only when [LDAP Authentication]
is selected in the [User Authentication] box.
P.103 “Setting up LDAP servers”

4, Enter the user credentials manually
When this check box is selected, you are prompted to enter your user name and password every time you send a
fax. This option is available when any of MFP Local Authentication, Windows Domain Authentication, or LDAP
Authentication is selected in the [User Authentication] box.

Tip
* To configure this option, select [Off] in the [Update Automatically] box.

* This option can be used together with any of the user authentication functions (MFP Local Authentication,
Windows Domain Authentication, LDAP Authentication).

5. Fax Function
Select whether or not the fax function is enabled. Set it to correspond to that of your MFP.

- Enabled — Select this to enable the fax function.
- Disabled — Select this to disable the fax function.

6. Internet Fax Function
Select whether or not the Internet Fax function is enabled. Set it to correspond to that of your MFP.

- Enabled — Select this to enable the Internet Fax function.
- Disabled — Select this to disable the Internet Fax function.

7. IP Fax Function
Select whether or not the IP Fax function is enabled. Set it to correspond to that of your MFP.

- Enabled — Select this to enable the IP Fax function.
- Disabled — Select this to disable the IP Fax function.

8. Cover Sheet confirmation
Select whether or not to display a message indicating a precaution that a cover sheet is being selected when a fax
jobis sent.

- Enable — Select this to display the message.
- Disable — Select this not to display the message.

9. Customization
The [Customization] dialog box is displayed.
P.102 “Customization: [Language] tab”

10. [Version Information]
Click this to display the software version information of the N/W-Fax driver.
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H Customization: [Language] tab
You can switch N/W-Fax driver language.

Customization *
Language 1
Auto ~
Restore Default 2
-

1. Language

This selects the language to be used.

- Auto / Chinese (Simplified, China) / Danish (Denmark) / Dutch (Netherlands) / English (United States) / Finnish
(Finland) / German (Germany) / Italian (Italy) / Spanish (Spain, Traditional Sort) / French (France) / Norwegian
Bokmal (Norway) / Russian (Russia) / Chinese (Traditional, Taiwan) / Turkish (Turkey) / Japanese (Japan) /
Polish (Poland) / Swedish (Sweden) / Portuguese (Brazil)

Tip
[Auto] is selected by default. When [Auto] is selected, the most appropriate printer driver language is
automatically set according to the regional and language settings in Windows OS.

2. [Restore Defaults]
Click this to restore the factory defaults on the [Language] tab.
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l Setting up LDAP servers
The [LDAP Server Settings] dialog box allows you to register LDAP servers.

LDAP Server Settings *
11— Update Mow
2 ———— Server Mame:
| LDAPO3|

33— Add
4 ————— Server Name List:

LDAPO1

LDAPO2

£ >
5— Delete

Cancel

1. [Update Now]
Click this to obtain LDAP server information automatically from your MFP, and register it in [Server Name List].

This function is not available when your computer and MFP are connected with a USB cable.

2. Server Name
Enter the desired LDAP server in this box if needed.

Tip
Up to 64 characters (excluding # ; \ =) can be entered for the [Server Name] box.

3. [Add]
Click this button to register the LDAP server in the [Server Name List], which has been entered in the [Server
Name] box.

4. Server Name List
The registered LDAP servers are displayed in this list. Up to 16 LDAP servers can be registered.

5. [Delete]
Click this button to delete an LDAP server in [Server Name List]. Select the LDAP server that you want to delete in
the list, and click this button.

Setting up the N/W-Fax Driver Options 103

(Xv4 Y4OMLIN) 4IAINA XV4-M/N ONISN



Sending With Extended Fax Functionality

The N/W-Fax driver allows users to perform the following features.

M Saving a fax as afile

You can save a document in the “TXFAX” folder in the “file_share” folder in the MFP as well as sending the document
to fax numbers and Email addresses.

1 Display the [Send] tab and select the [Save as File] check box.

#=h TOSHIBA e-5TUDIO Fax Printing Preferences *
Layout Send
Send to
Address _01...

To Remove

Display Name Fax Number/Address

< >

(@) Fax Number SUB/PWD...

O Intemet Fax Address

Resolution _, Department Code
Standard (200 x 100 dpi) ~ o
Cover Sheet- Hide Department Code
Eﬂ e e -
EE — Select from —
SNMP Settings
[ Send Cower Sheet Orly = 2
{0) [Dslayed Fax 8/12/2021 2:06 PM di
™. i File Format:
=
TIFFMULTY) ~| [Jocr

Restore Defautts Help

Conce | | tomy

2 Select the file format in the [File Format] box.

\_\) [ Delayed Fax 8/12/2021 2.06 FM

. File Format
= Save as File i

Restore Defautts PDF(SINGLE) Help

Specify the other options to send a document and click [OK].

S W

Click [OK] (or [Print]) to send a document to the MFP.
The document is saved in the “TXFAX” folder in the “file_share” folder in the MFP.
Tip

e The saved file contains the cover sheet when the cover sheet is set.

* Since the image smoothing function does not work for the image stored in the “file_share” folder, its printing
image quality differs from the normal fax image quality.
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H Delayed transmission reservation

When the delayed transmission is specified, the fax is stored in the fax queue in the MFP and will be sent at the

specified date and time.

1 Display the [Send] tab and select the [Delayed Fax] check box.

=h TOSHIBA e-STUDIO Fax Printing Preferences

Layout Send

Sendto 1
Address Bo....

b Remove

Display Name Fax Number/Address

(@) Fax Number SUB/PWD
O Intemet Fax Address

Resolution: ., Department Code:

2 Standard (200 x 100 dpi) - s

Cover Sheet Hide Department Code

[Z]] [Standard Cover Page -

Edt — Select from —

SNMP Sett
[ Send Cover Sheet Orily M ings

(D) &Odiayed Fad [8/12/2021 2.06 PM Edit
™, _
oy lk- 2 Fie
TIFF(MULTI) OCR
Restore Defaults Help
Cancel

*

2 Click [Edit].
The [Scheduled Time] dialog box appears.

3 Select the date and time and click [OK].

Scheduled Tirne

Date: /02022 [ |

Iime:| 230 PM

Cancel

* You can click the arrow in the Date box to display a calendar that allows you to select a date.

* Enter the time to start the fax transmission. You can use the up and down arrows.

v A

Specify the other options to send a document and click [OK].

Click [OK] (or [Print]) to send a document to this equipment.
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H Sending with a cover sheet

You can choose to send a cover sheet with your fax transmission. You can select what to include on the cover sheet

such as sender or recipient information.

* When a printer driver whose name consists of 54 letters or more is specified for the default printer and an attempt
is made to send a fax with a cover sheet added from Microsoft Excel using a N/W-Fax driver with an IPP port, an XL
error may occur and fax transmission may be impossible. (This error does not occur in application software other

than Microsoft Excel.)

If this error occurs, perform one of the following and start sending a fax again.

- Use 30 letters or less for the N/W Fax driver name.

- Do not attach any cover sheet.
* Emoji is not available for a cover sheet.

1 Display the [Send] tab, select the cover sheet type in the [Cover Sheet] box and then click [Edit].

=0 TOSHIBA e-STUDIO Fax Printing Preferences

Layout Send

Send to 1
Address Bo
To

Display Name Fax Number/Address

(®) Fax Number
O Intemet Fax Address

Resolution:

SUB/PWD...

_, Department Code:

Standard (200x 100 dpi) - )
Caver Sheet: Hide Depariment Code
I:ﬂ Etandard Cover Page Te
Edit — Select from —
SNMP Settings
[0 Send O e Orly % o 9
) [ Delayed Fax 8/12/2021 2:06 PM Edit...
™
oy [saveasFie
TIFF(MULT OCR
Restore Defaults Help
Cancel Aoply

The [Cover Sheet Settings] dialog box appears.
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Enter the title of the cover sheet in the [Header Text] box.

Cover Sheet Settings

| FACSIMILE TRANSMITTAL

Detail Format
Large Preview

Fonts
Font for:

Footer
Image File:

I

G| S E

Restore Defaults

Header ~ Edit...

Browse...

Please note that Emoji cannot be used for the Cover Sheet.

Cover Sheet Name:

*

‘ Standard Cover Page

Header Text

| FACSIMILE TRANSMITTAL|

Text Area Details
[ reference Number

[ redipients Information

Name Company
Department Name Fax Number
[ sender Information
[ subject
[]Message
o

Help

You can enter up to 63 characters for the header text.

If you want a reference number identifying the document to appear on the cover sheet, select the
[Reference Number] check box and then enter the reference number in the text box.

Cover Sheet Settings

‘ FACSIMILE TRANSMITTAL

Cover Sheet Name:

x

| Standard Cover Page

Header Text

‘ FACSIMILE TRANSMITTAL

Text Area Details
Reference Number

‘ 0000000001

|| redpients Information
Name Company

Department Name Fax Number

You can enter up to 20 characters for the reference number.

If you want the recipient’s information to appear on the cover sheet, select the [Recipient
Information] check box and then select the options required for the recipient information.

Cover Sheet Settings

| FACSIMILE TRANSMITTAL

Detail Format

Cover Sheet Name:

ey

| Standard Cover Page

Header Text

| FACSIMILE TRANSMITTAL

Text Area Details
Reference Number

|uuuuuuuuul

Recipients Information
Name Company

Department Name 3

[[]sender Information

Name — Check this to have the name of the recipient appear on the cover sheet.

Company — Check this to have the company name of the recipient appear on the cover sheet.

Department Name — Check this to have the department name of the recipient appear on the cover sheet.
Fax Number — Check this to have the fax number or Email address of the recipient appear on the cover sheet.
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* Recipient information is obtained from the address book. If the recipient is added manually, this information
does not appear on the cover sheet except for the fax number or Email address.

* The recipient information for all recipients will appear on the cover sheet.

5

If you want sender information to appear on the cover sheet, select the [Sender Information]
check box and then enter the sender information in the text box.

Name Company
[Z] Department Name [] Fax Number
Detai Format Sender Information
7 P Sponsored: 00000 CORPORATION
S Freview Supported: ABCD CORPORATION|
Fonts
Fant for:
Header ~ Edit...
[ subject
Footer
Image File:
) ] =
Restore Defaults
Please note that Emaji cannot be used for the Cover Sheet. e Help

You can enter up to 500 characters for the sender information.

6

If you want a subject to appear on the cover sheet, select the [Subject] check box and then enter
the subject in the text box.

Detail Format Sender Information
7 P Sponsered: 00000 CORPORATION
SRS S Supported: ABCD CORPORATION
Fonts
Fant for:
Header ~ Edit...
Subject
Footer Information|
Image File:
&)= E

Restore Defaults

Please note that Emaji cannot be used for the Cover Sheet.

Cancel Help

You can enter up to 40 characters for the subject.

7

If you want a message to appear on the cover sheet, select the [Message] check box and then
enter the message in the text box.

Detail Format |+] Sender Information

7 P Sponsored: 00000 CORPORATION
Suctiewen Supported: ABCD CORPORATION
Fonts
Fant for:
Header ~ Edit...
Subject
Footer Information
Image File:
e Please refer to the attached information.|
) B E

Restore Defaults

Please note that Emaji cannot be used for the Cover Sheet.

concel | | e

You can enter up to 500 characters for the message.
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8 If you want to change the font of the characters on the cover sheet, select the corresponding
section in the [Font for] box, and then click [Edit].

Detzil Format ] 5ender Information

Sponsored: 00000 CORPORATION

Large Preview Supported: ABCD CORPORATION

Fonts
Font for:

Edit .
% Subject

‘ Information

L ] o ==

Please refer to the attached information.

e ] Ji=] 0]

Restore Defaults

conce

Help

The [Font] dialog box appears.

If you do not change the font, proceed to step 10.

9 Select the desired one from each of the [Font], [Font style], [Size] and [Script] boxes, and then

click [OK].
Font X
Font: Font style: Size:

Arial Bold [E
R - co I
Bahnschrift Italic i‘;
caitn “
Cambria Boid Italic E
Cambria Math Black
Candara v | |Black Obligue

Sample
Script:
‘ Western ~ |
Show more fonts

The [Font] dialog box is closed and the font settings are determined for the selected section.

Tip

If you want to change the font of other sections, repeat the procedure from step 8.

10 If you want to attach an image file on the footer, click [Browse] of Image File.

Detail Format |w] Sender Information

Sponsered: 00000 CORPORATION

Large Preview Supported: ABCD CORPORATION

Fonts
Font for:

Header ~ Edit...

Subject
Footer ‘ Information
Image File:
‘ ‘ Browse... Message
Please refer to the attached information.
Delete
e =] 1]

Restore Defaults

oK Cancel

Help

The [Open] dialog box appears.

If you do not attach an image file, proceed to step 13.
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11 Select an image file to be attached and then click [Open].

Open X
« v p » ThisPC » Desktop » fax_logo v | O Search fax_logo
Organize = New folder ==~ OO @
~
H Videos () MNarne Date Type
o OneDrive ] FAX_logo-01 333 PM BMP File
- & FAX logo-0 1 1:36 PM BMP File Select afile
i to preview.
This PC &) FAX_loge-03 1:36PM BMP File o previen
§ 3D Objects
[ Desktop v € >
File name: |FAX_\ogo—03 ~| |*bmp ~

The [Open] dialog box is closed and the selected image file is attached.

Attach the image file in a bitmap format (.bmp) within 1 MB.

12 Select the position of the image file.

Cover Sheet Settings X

Cover Sheet Name:

| FACSIMILE TRANSMITTAL \ Standard Cover Page |

Header Text

| FACSIMILE TRANSMITTAL |

Text Area Details
Reference Number

| 0000000001 |
\/@ Redipients Information
4 Name Company
Department Name Fax Number
Detail Format Sender Information

Sponsored: 00000 CORPORATION

Large Preview Supparted: ABCD CORPORATION

Fonts
Font for:
Header ~ Edit...
Subject
Footer Information
Image File:

FAX_logo-01.bmp Browse... Message

Please refer to the attached information.

e Delate ey

Position:

Restore Defaults

oK Cancel Help

- [£]]: Select this to align the image to the left.

- [2]': Select this to align the image to the center.

- [L2]: Select this to align the image to the right.
13 Specify the other options to send a document and click [OK].
14 Click [Print] to send a document to the MFP.
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Internet Fax Features

Internet Fax allows a copy of a scanned document to be sent as an E-mail with an attached TIFF-FX (Profile S) file.
Since an Internet line is used instead of a phone line, the communication costs can be dramatically reduced.
With Internet Fax, an E-mail address is to be specified in place of a phone number to transmit a copy of a scanned
document to the Internet Fax equipment or the client computers.

When an Internet Fax is received, it is automatically output just like a traditional fax.

Internet faxing requires the network settings configured by the network administrator. Consult your network
administrator for help.

With Internet Fax, you can perform various transmissions as illustrated below.

e Internet Fax Equipment to Internet Fax Equipment
The equipment can send a copy of a document to other Internet Fax equipment via Internet or Intranet. The copy of

the document is sent as an E-mail.

Internet
Intranet

Mail server Mail server

— E-mail transmission
— LAN

* Internet Fax Machine to/from Client Computers

The equipment can send a copy of a document as an E-mail to client computers via Internet or Intranet. The client
computers can send an E-mail to the equipment as well.

Client computer Mail server Mail server Client computer

— E-mail transmission
— LAN

* When the equipment sends a copy of a document using Internet Fax, the client computer receives the copy as TIFF-

FX (Profile S) images.
* The MFP can print out only text files and image files in TIFF format; from the client computer, you cannot send files
other than text or TIFF images to the MFP. For available formats, see the reference below:

P.116 “Available file formats”
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Precautions for Internet Fax Transmissions

Internet Fax works just like e-mail and may cause the same kinds of troubles as E-mail unless you understand how it
works. Before you start using the Internet Fax feature, carefully read and familiarize yourself with the following
precautions:

*

Internet Fax sends a copy of a document to your E-mail server, not via the PSTN* as with a traditional fax. The data
is then sent from the server to the Internet. Unlike traditional faxing, Internet faxing does not involve a direct
communication with the recipient(s). Transmission is considered complete when the sent copy of the document

reaches your E-mail server.

The security level of Internet transmissions is low. We recommend traditional faxing when sending confidential

documents.

Due to heavy line traffic, Internet transmissions may take a while to arrive.
The configuration of the E-mail server may prevent successful transmission if the data size of the sent document

exceeds set limits.

When you send an Internet fax to multiple recipients, all the recipients’ E-mail addresses are printed if the header
page is set to be printed on the recipients devices. If you need to secure the personal information, send the Internet
fax separately to each recipient rather than sending to multiple recipients at the same time.

PSTN (Public Switched Telephone Network) is a global telephone system capable of communicating worldwide using copper wires to transmit

analog data.
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Sending Internet Faxes

Just like the Scan to E-mail function, Internet Fax sends scanned data to specified E-mail addresses as an attached
file. The difference is the format of the file; it is TIFF-FX (Profile S), which can be received and printed on Internet Fax
devices. With a few additional steps, you can also save the sent data or set advanced functions for each transmission.

To use the Internet Fax feature, the network administrator must set the equipment configuration.

H Sending Internet faxes

1 Place the original(s).
P.14 “Placing an original”

2 Press [Fax] on the Home screen.

3 Set the transmission conditions.

* Original Size
Press the corresponding button for the original size. To have the equipment automatically set the original size,
press [Auto].
When using originals of various paper widths, press [Different Width].
P.22 “Setting the original size”

* Resolution
Select the resolution for scanning the original.
P.23 “Setting the resolution”

For the setting items related to the internet fax which should be set as other transmission conditions, see the
reference below:
P.24 “Setting other transmission conditions”

e Exposure
Select the appropriate exposure for scanning the original. Pressing [Auto] automatically sets the exposure

best suited to your originals. To set the exposure manually, use Il or Bl to select the appropriate exposure.

¢ Original Mode
Select an original mode to scan the original for the best image quality.

- [Text/Photo] — Press this button to scan an original consisting of both text and photos.
- [Text] — Press this button to scan an original consisting of text.
- [Photo] — Press this button to scan an original containing photo images printed on photographic paper.

¢ 2-Sided Scan
Select the type (1-sided or 2-sided) of the original to be scanned
Single: Press this button to scan a 1-sided original.
Book: Press this button to scan a 2-sided right-to-left (book-type) original.
Tablet: Press this button to scan a 2-sided top-to-bottom (tablet-type) original.

* TxType
When sending an Internet Fax, you can only select [Memory Tx].
P.24 “Setting other transmission conditions”

* [Subject]
Enter the subject of the Internet Fax to be sent.

* [Body]
Enter the body message of the Internet Fax to be sent.

* Allthe settings required for Internet faxing are mentioned in the above steps. Settings other than the above
apply only to fax transmissions.

* When sending an Internet Fax, [Fine] is always applied even if you select [U-Fine] in Resolution.

* Internet faxing sends copies of A4, LT or LG size originals in the same size as the originals’. Originals larger than
A4, LT, or LG are reduced to A4 or LT, whereas originals smaller than these sizes are sent as A4 or LT without
being enlarged.
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Tip
* When either [Text/Photo] or [Photo] is selected in Original Mode, the transmission may take a while.

* The administrator can change the body message from TopAccess. For details, see the reference below:
TopAccess - [Administration] - [Setup] Item List - InternetFax settings - Setting up InternetFax Setting

4 Specify the E-mail address of the recipient.
P.27 “Specifying the recipient”

Tip

You can save the sent data as a file.
P.114 “Sending Internet Faxes”

5 Press [Send].
P.19 “Sending a Fax”

l Setting advanced functions

The following advanced functions can be set during an Internet faxing operation. The setting method for these
functions is the same as that for those of the general fax sending operation. For details, see the reference below:

* Priority Reserve — Use this function when you want to send originals ahead of the currently reserved
transmissions.
P.51 “Communicating to a Request from a Recipient (Polling Communication)”

l Saving data sent in a file along with internet fax transmission

When sending an Internet fax, you can also save the sent data in the equipment’s shared folder and/or a network
folder (Remote 1 or 2).

* Tosave the data in a network folder, the administrator needs to set the equipment configuration. For details, see
the reference below:
TopAccess - [Administration] - [Setup] Item List - Save as file settings - Setting up Destination

* Internet Fax and File is not available when the forced encryption setting is enabled. To learn more about the forced
encryption setting, see the reference below:
User Functions - SETTING ITEMS (Admin) - Security - Setting secure PDF
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Receiving Internet Faxes

H Available file formats

The equipment can print out TIFF-FX images, TIFF images scanned in black and white, and text data (E-mail messages
in the plain text format). In addition, the resolution of the TIFF-FX images must be either 8 x3.850r8x7.70r8x15.4
(dot/mm) while that of scanned TIFF images must be 200 x 100, 200 x 200, 200 x 400, 400 x 400, or 600 x 600 (dpi).

If any files failing to meet the above conditions are attached to a received Internet Fax, an E-mail printing error occurs
and is recorded as an error code on the Receive log. On TopAccess, the “Email Print” settings are available for the
administrator so that error codes can be printed as a report. The administrator can also set the equipment to forward
such Internet Faxes to another E-mail address. For details, see the references below:

TopAccess - [Administration] - [Setup] Item List - InternetFax settings - Report Setting

TopAccess - [Administration] - [Registration] ([Administration]) Item List - Fax Received Forward and
InternetFAX Received Forward settings

M Receiving Internet faxes

The equipment accesses the E-mail server at specified intervals to check whether any E-mail has been delivered. New
E-mail is automatically received and printed out unless you check manually.

Tip
Internet Fax reception settings can be changed from TopAccess.

For details, see the reference below:
TopAccess - [Administration] - [Setup] Item List - InternetFax settings - Setting up InternetFax Setting

O Receiving Internet Faxes automatically

The administrator can set up the equipment configuration on TopAccess to automatically receive Internet faxes from
the E-mail server. If the “Scan Rate” setting is specified, the equipment accesses the E-mail server to check for any
new E-mail at specified intervals. (The factory default is 5 minutes.) For details, see the reference below:

TopAccess - [Administration] - [Setup] Item List - Network settings - Setting up POP3 Client

O Receiving Internet Faxes manually

1 Press [User Functions -User-] on the Home screen.

2 On the [User] tab, press [Check E-mail].
L& User Functions

m A < ¢

Fax Scan e-Filing

.I = | 2e

Check
E-mail

v

Admin

Address Internet Fax

Job Status

* The equipment begins checking for new E-mail. If Internet Faxes have been received, “RECEIVING E-mail”
appears on the screen. After “NEW E-mail RECEIVED” is displayed, the equipment starts printing the Internet
Faxes.

* |f no new E-mail are found, “CURRENTLY NO E-mail” is displayed on the screen.
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PRINTING LISTS AND REPORTS
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TRANSMISSION JOURNAL

Item name Description

ROM version Firmware version of the FAX Unit and the MFP. This appears at the upper right of the
list.

TIME Date and time of the output of the journal

FAXNO.1 Sender’s fax number (line 1)

FAXNO.2"! Sender’s fax number (line 2)

NAME Registered terminal ID (line 1)

NAME (LINE2) Registered terminal ID (line 2)

NO. Serial number assigned to each communication (001 to 999)

FILE NO. File number for communication

DATE TIME Start date and time for communication

DURATION Communication period (indicated by a “minutes:seconds” form)

PGS Number of pages for communication

TO Communicated destination telephone number or name registered in the address book
Ifthe # markisindicated, the 2nd fax number registered in the address book has
been used.

DEPT Department code
(If the department control is not performed, this field will become blank.)

MODE Communication mode (2 digits) and transmission method (3 digits) or special
communication mode (2 digits)
If the # markisindicated, the 2nd line has been used.
See the following table for the codes displayed in this field.

STATUS Communication result and error code
* OK: Completed successfully
* NG: Completed abnormally
* 4-digit error code: Communication failed
For details about the error codes, see the reference below:
Frequently Asked Questions - QUESTIONS FOR ERROR CODES - Questions for Error
Codes - Error codes on transmission and reception

*1 Thisitem is not available to some models.

Mode: 1. Communication mode

Display Communication mode
EC ECM communication
G3 G3 communication
ML Email communication
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Mode: 2. Transmission method

Display Transmission speed Resoluti.on Encoding systems
(bps) (pels/min)
0 2,400 8x3.85 MH
1 4,800 8x7.7 MR
2 7,200 8x15.4 MMR
3 9,600 JBIG
4 12,000 16x15.4
5 14,400
6 V.34
7
8 300 dpi
B 600 dpi
D 150 dpi
C 100 dpi

Mode: 3. Special communication mode

Display Special communication mode
P Polling communication
SB Mailbox communication
SR,R Relay mailbox communication
SF, F Forward mailbox communication
ML Internet Fax communication
I N/W-fax communication
0 Offramp Gateway communication
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RECEPTION JOURNAL

Item name Description

ROM version Firmware version of the FAX Unit and the MFP. This appears at the upper right of the
list.

TIME Date and time of the output of the journal

FAXNO.1 Sender’s fax number (line 1)

FAXNO.2"! Sender’s fax number (line 2)

NAME Registered terminal ID (line 1)

NAME (LINE2) Registered terminal ID (line 2)

NO. Serial number assigned to each communication (001 to 999)

FILE NO. File number for communication

DATE TIME Start date and time for communication

DURATION Communication period (indicated by a “minutes:seconds” form)

PGS Number of pages for communication

FROM Communicated destination telephone number or name registered in the address book
Ifthe # markisindicated, the 2nd fax number registered in the address book has
been used.

DEPT Department code

(If the department control is not performed, this field will become blank.)

MODE Communication mode (2 digits) and transmission method (3 digits) or special
communication mode (2 digits)

Ifthe # markisindicated, the 2nd line has been used. See the following table for the
codes displayed in this field.

STATUS Communication result and error code

* OK: Completed successfully

* NG: Completed abnormally

* 4-digit error code: Communication failed

For details about the error codes, see the reference below:

Frequently Asked Questions - QUESTIONS FOR ERROR CODES - Questions for Error
Codes - Error codes on transmission and reception

*1 Thisitem is not available to some models.

Mode: 1. Communication mode

Display Communication mode
EC ECM communication
G3 G3 communication
ML Email communication
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Mode: 2. Transmission method

Display Transmission speed Resoluti.on Encoding systems
(bps) (pels/min)
0 2,400 8x3.85 MH
1 4,800 8x7.7 MR
2 7,200 8x15.4 MMR
3 9,600 JBIG
4 12,000 16x15.4
5 14,400
6 V.34
7
8 300 dpi
B 600 dpi
D 150 dpi
C 100 dpi

Mode: 3. Special communication mode

Display Special communication mode
P Polling communication
SB Mailbox communication
SR,R Relay mailbox communication
SF, F Forward mailbox communication
ML Internet Fax communication
I N/W-fax communication
0 Offramp Gateway communication

RECEPTION JOURNAL 121

SLY0d3Y ANY S1SITONILNIEd



RESERVATION LIST

Item name Description

TIME Date and time of the output of the journal

FAXNO.1 Sender’s fax number (line 1)

FAX NO.2"1 Sender’s fax number (line 2)

NAME Registered terminal ID (line 1)

NAME (LINE2) Registered terminal ID (line 2)

TX/RX Reserved jobs for transmission/reception

RECOVERY TX Reserved jobs which are made by recovery transmission

PCJOB Reserved jobs which are made from a client computer

FILE NO. File number for communication

DATE TIME Start date and time for communication

FUNCTION Type of transmission/reception

PGS Number of pages for communication

TO Communicated destination telephone number or name registered in the address book.
If the #8 markisindicated, the recipient has been specified with the direct entry
method.
If a G mark is indicated, the recipient has been specified with the group entry method.

DELAY TIME Specified time for transmission (if registered)

*1 Thisitem is not available to some models.
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MAILBOX/RELAY BOX REPORT

Item name Description
TIME Date and time of the output of the journal
FAXNO.1 Sender’s fax number (line 1)
FAXNO.2"! Sender’s fax number (line 2)
NAME Registered terminal ID (line 1)
NAME (LINE2) Registered terminal ID (line 2)
MAIL BOX History of confidential mailbox job and bulletin board mailbox job
RELAY History of relay station mailbox job

FORWARD/INBOUND
FAX(TSI)

History of forwarded jobs and inbound fax jobs (TSI)

BOX NO. Box number of the communication destination
BOX TYPE Type of communication
PGS Number of pages for communication
FILE NO. File number for communication
DATE TIME Start date and time for communication
FROM Originator of jobs
END STATION ID code of the end station
This field indicates an E-mail address by a 4-digit number and a group ID by a 3-digit
number.
REPLY TO NUMBER Telephone number of the reply destination
AGENT Type of the agent
DESTINATION Details of the forwarded recipient

*1 Thisitem is not available to some models.
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MEMORY TRANSMISSION REPORT

Item name Description

TIME Date and time of the output of the journal

FAXNO.1 Sender’s fax number (line 1)

FAX NO.2"1 Sender’s fax number (line 2)

NAME Registered terminal ID (line 1)

NAME (LINE2) Registered terminal ID (line 2)

FILE NO. File number for communication

DATE Reception date and time for communication

TO Communication destination
Ifthe # markisindicated, the 2nd fax number registered in the address book has
been used.
If the #8 markis indicated, the recipient has been specified with the direct entry
method.

DOCUMENT PAGES Number of original pages to be transmitted

START TIME Start date and time for communication

END TIME End date and time for communication

PAGES SENT Number of pages for communication

STATUS Communication result and error code

* OK: Completed successfully

* NG: Completed abnormally

* 4-digit error code: Communication failed

For details about the error codes, see the reference below:

Frequently Asked Questions - QUESTIONS FOR ERROR CODES - Questions for Error
Codes - Error codes on transmission and reception

*1 Thisitem is not available to some models.
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TRANSMISSION REPORT

Item name Description

ROM version Firmware version of the FAX Unit and the MFP. This appears at the upper right of the
list.

TIME Date and time of the output of the journal

FAXNO.1 Sender’s fax number (line 1)

FAXNO.2"! Sender’s fax number (line 2)

NAME Registered terminal ID (line 1)

NAME (LINE2) Registered terminal ID (line 2)

NO. Serial number assigned to each communication (001 to 999)

FILE NO. File number for communication

DATE TIME Start date and time for communication

DURATION Communication period (indicated by a “minutes:seconds” form)

PGS Number of original pages transmitted

TO Communicated destination telephone number or name registered in the address book.
Ifthe # markisindicated, the 2nd fax number registered in the address book has
been used.

DEPT Department code
(If the department control is not performed, this field will become blank.)

MODE Communication mode (2 digits) and transmission method (3 digits) or special
communication mode (2 digits)
If the # markisindicated, the 2nd line has been used.
See the following table for the codes displayed in this field.

STATUS Communication result and error code
* OK: Completed successfully
* NG: Completed abnormally
* 4-digit error code: Communication failed
For details about the error codes, see the reference below:
Frequently Asked Questions - QUESTIONS FOR ERROR CODES - Questions for Error
Codes - Error codes on transmission and reception

*1 Thisitem is not available to some models.
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MULTI TRANSMISSION REPORT

Item name Description

TIME Date and time of the output of the journal

FAXNO.1 Sender’s fax number (line 1)

FAXNO.2"! Sender’s fax number (line 2)

NAME Registered terminal ID (line 1)

NAME (LINE2) Registered terminal ID (line 2)

FILE NO. File number for communication

DATE Reception date and time for communication

START TIME Start date and time for communication

END TIME End date and time for communication

SUCCESSFUL Recipient whose communication was completed successfully

UNSUCCESSFUL Recipient whose communication was completed abnormally

ADDRESS BOOK Communicated destination name registered in the address book.
Ifthe # markisindicated, the 2nd fax number registered in the address book has
been used.

FAX NUMBER Registered name of communicated destination telephone number.
If the #8 markisindicated, the recipient has been specified with the direct entry
method.

PAGES SENT Number of pages for communication

*1 Thisitem is not available to some models.

126 MULTI TRANSMISSION REPORT




MULTI POLLING REPORT

Item name Description

TIME Date and time of the output of the journal

FAXNO.1 Sender’s fax number (line 1)

FAXNO.2"! Sender’s fax number (line 2)

NAME Registered terminal ID (line 1)

NAME (LINE2) Registered terminal ID (line 2)

FILE NO. File number for communication

DATE Reception date and time for communication

START TIME Start date and time for communication

END TIME End date and time for communication

SUCCESSFUL Recipient whose communication was completed successfully

UNSUCCESSFUL Recipient whose communication was completed abnormally

ADDRESS BOOK Communicated destination name registered in the address book

FAX NUMBER Registered name of communicated destination telephone number.
If the #8 markis indicated, the recipient has been specified with the direct entry
method.

*1 Thisitem is not available to some models.
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RELAY TX ORIG. TERMINAL REPORT

Item name Description

TIME Date and time of the output of the journal

FAXNO.1 Sender’s fax number (line 1)

FAXNO.2"! Sender’s fax number (line 2)

NAME Registered terminal ID (line 1)

NAME (LINE2) Registered terminal ID (line 2)

FILE NO. File number for communication

DATE Reception date and time for communication

TO Communicated destination telephone number or name registered in the address book.
If the #8 markis indicated, the recipient has been specified with the direct entry
method.

RELAY BOX Box number of the communication destination

DOCUMENT PAGES Number of original pages to be transmitted

START TIME Start date and time for communication

END TIME End date and time for communication

PAGES SENT Number of pages for communication

STATUS Communication result
* OK: Completed successfully
* NG: Completed abnormally

*1 Thisitem is not available to some models.
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RELAY TX RELAY STATION REPORT

Item name Description

TIME Date and time of the output of the journal

FAXNO.1 Sender’s fax number (line 1)

FAX NO.2"1 Sender’s fax number (line 2)

NAME Registered terminal ID (line 1)

NAME (LINE2) Registered terminal ID (line 2)

FILE NO. File number for communication

DATE Reception date and time for communication

DOCUMENT PAGES Number of original pages to be transmitted

FROM Telephone number of the originator

START TIME Start date and time for communication

END TIME End date and time for communication

RELAY BOX Box number of the communication destination

SUCCESSFUL Recipient whose communication was completed successfully

UNSUCCESSFUL Recipient whose communication was completed abnormally

GROUP NUMBER Group number of the communicated destination

ADDRESS BOOK Communicated destination name registered in the address book
Ifthe # markisindicated, the 2nd fax number registered in the address book has
been used.

PAGES SENT Number of pages for communication

*1 Thisitem is not available to some models.
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RELAY TX END TERMINAL REPORT

Item name Description

TIME Date and time of the output of the journal

FAXNO.1 Sender’s fax number (line 1)

FAX NO.2"1 Sender’s fax number (line 2)

NAME Registered terminal ID (line 1)

NAME (LINE2) Registered terminal ID (line 2)

FILE NO. File number for communication

DATE Reception date and time for communication

DOCUMENT PAGES Number of original pages to be transmitted

FROM Telephone number of the originator

START TIME Start date and time for communication

END TIME End date and time for communication

RELAY BOX Box number of the communication destination

SUCCESSFUL Recipient whose communication was completed successfully

UNSUCCESSFUL Recipient whose communication was completed abnormally

GROUP NUMBER Group number of the communicated destination

ADDRESS BOOK Communicated destination name registered in the address book.
Ifthe # markisindicated, the 2nd fax number registered in the address book has
been used.

PAGES SENT Number of pages for communication

*1 Thisitem is not available to some models.
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RELAY STATION REPORT

Item name Description
TIME Date and time of the output of the journal
FAXNO.1 Sender’s fax number (line 1)
FAX NO.2"1 Sender’s fax number (line 2)
NAME Registered terminal ID (line 1)
NAME (LINE2) Registered terminal ID (line 2)
FILE NO. File number for communication
DATE Reception date and time for communication
RELAY BOX Box number of the communication destination
DOCUMENT PAGES Number of original pages to be transmitted
FROM Telephone number of the originator

*1 Thisitem is not available to some models.
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MAILBOX RECEPTION REPORT

Item name Description
TIME Date and time of the output of the journal
FAXNO.1 Sender’s fax number (line 1)
FAX NO.2"1 Sender’s fax number (line 2)
NAME Registered terminal ID (line 1)
NAME (LINE2) Registered terminal ID (line 2)
FILE NO. File number for communication
DATE Reception date and time for communication
BOX NUMBER Box number of the communication destination
BOX TYPE Type of communication
DOCUMENT PAGES Number of original pages to be transmitted
FROM Telephone number of the originator

*1 Thisitem is not available to some models.
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